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For Océ and Imagistics Models




Thank you for selecting an Océ solution for your document production and
management needs. The following information will help you get the most
productive and reliable use out of your system.

Oceé brand supplies are designed for Océ copiers, printers and fax machines to
ensure maximum product performance and quality. Substituting other supplies
may result in inferior image quality and machine malfunction.
To order supplies call the Océ Supply Line:

1-800-462-6797 (US)

1-866-462-4478 (CAN)

01277 846 146 (UK)

Should your system develop a problem that cannot be remedied by using the
maintenance or troubleshooting procedures outlined in this manual, please contact
Océ Technical Support by calling:

1-800-243-5556 (US)

1-866-462-4478 (CAN)

08708 500 749 (UK)

For faster service, please have your machine model and serial number available
before calling.

Serial Number:

This product was first introduced by Imagistics International Inc. and is now a part
of the Océ product line. Please be aware that while some components may still
carry the Imagistics name and markings, they are fully compatible with the Océ
brand system.

Www.0oce.com



SOFTWARE LICENSE AGREEMENT

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE
LICENSE IS PROVIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE
SUCH SEPARATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU
MAY NOT INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL
SOFTWARE COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE
AGREEMENT (“EULA”). INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED
HEREWITH; HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CRE-
ATED BY OR FOR Océ North America, Corporate Printing Divisio (“Océ”) ARE PROPRIETARY
PRODUCTS OF Océ AND ARE PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL
TREATY PROVISIONS, AND OTHER APPLICABLE LAWS.

Grant of License

This is a legal agreement between you, the end-user (“You”), and Océ and its suppliers. This
software, fonts (including their typefaces) and related documentation (“Software”) is licensed for
use with the system CPU on which it was installed (“System”) in accordance with the terms con-
tained in this Agreement. This Software is proprietary to Océ and/or its suppliers.

Océ and its suppliers disclaim responsibility for the installation and/or use of this Software, and
for the results obtained by using this Software. You may use one copy of the Software as
installed on a single System, and may not copy the Software for any reason except as neces-
sary to use the Software on a single System. Any copies of the Software shall be subject to the
conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse
compile, reverse assemble, or reverse engineer the Software. You may not use the Software,
except in accordance with this license. No title to the intellectual property in the Software is
transferred to you and full ownership is retained by Océ or its suppliers. Source code of the Soft-
ware is not licensed to you. You will be held legally responsible for any copyright infringement,
unauthorized transfer, reproduction or use of the Software or its documentation.

Term

This license is effective until terminated by Océ or upon your failure to comply with any term of
this Agreement. Upon termination, you agree to destroy all copies of the Software and its docu-
mentation.

You may terminate this license at any time by destroying the Software and its documentation
and all copies.

Disclaimer of Warranty

THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-
INFRINGEMENT. Océ AND ITS SUPPLIERS DISCLAIM ANY WARRANTY RELATING TO THE
QUALITY AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE PROVES
DEFECTIVE, YOU (AND NOT Océ OR ITS SUPPLIERS) SHALL BE RESPONSIBLE FOR THE
ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. Océ AND ITS
SUPPLIERS DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE
WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL
BE UNINTERRUPTED OR ERROR FREE.
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ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY Océ AND ITS AFFILIATES
PURSUANT TO A EULA IS PROVIDED “AS 1S” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED.

Limitation of Liability

IN NO EVENT WILL Océ OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES,
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR
DEATH RESULTING FROM NEGLIGENCE ON THE PART OF Océ OR ITS SUPPLIERS),
INCLUDING WITHOUT LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR
OTHER INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF Océ OR ITS SUPPLIERS HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY
CLAIMS.

U.S. Government Restricted Rights

The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the
U.S. Government is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the
Rights in Technical Data and Computer Software Clause set forth in 252.227-7013, or 52.227-19
(c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is Océ North America, Corpo-
rate Printing Divisio, 100 Oakview Drive, Trumbull CT 06611.

General

You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt
to sublicense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is
void. You agree that you do not intend to, and will not ship, transmit (directly or indirectly) the
Software, including any copies of the Software, or any technical data contained in the Software
or its media, or any direct product thereof, to any country or destination prohibited by the United
States Government. This license shall be governed by the laws of Japan or, at the election of a
Supplier of Océ concerned with a dispute arising from or relating to this Agreement, the laws of
the Country designated from time to time by the relevant Supplier of Océ. If any provision or por-
tion of this Agreement shall be found to be illegal, invalid or unenforceable, the remaining provi-
sions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT
YOU UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS. YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE
COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND Océ AND ITS SUPPLI-
ERS AND SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN,
OR ANY OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS
LICENSE AGREEMENT.

Océ North America, Corporate Printing Divisio, 100 Oakview Drive, Trumbull CT 06611.
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TRADEMARKS AND COPYRIGHT

Trademarks

* The official name of Windows 98 is Microsoft Windows 98 Operating System.

¢ The official name of Windows Me is Microsoft Windows Me Operating System.

* The official name of Windows 2000 is Microsoft Windows 2000 Operating System.

* The official name of Windows XP is Microsoft Windows XP Operating System.

* The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating
System.

* Microsoft, Windows, Windows NT, and the brand names and product names of other
Microsoft products are trademarks of Microsoft Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, TrueType, and LaserWriter are trademarks of Apple
Computer, Inc. in the US and other countries.

* Postscript is a trademark of Adobe Systems Incorporated.

* Netscape is a trademark of Netscape Communications Corporation.

* |IBM, AT and AlX are trademarks of International Business Machines Corporation.

e NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

¢ Other company names and product names in this manual are the trademarks of their respec-
tive companies.

Copyright
© 2005 Océ North America, Corporate Printing Divisio All rights reserved
Under the copyright laws, this manual cannot be reproduced in any form without prior written

permission of Océ. No patent liability is assumed, however, with respect to the use of the infor-
mation contained herein.
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Preface

Thank you for purchasing im4530 Series or im2830 Series Multifunctional Digital Systems. This
Network Administration Guide explains the instructions for administrators to set up and manage
the im4530 Series or im2830 Series. Read this guide before using to your im4530 Series or
im2830 Series. Keep this guide within easy reach, and use it to configure an environment that
makes best use of the system’s functions.

About This Guide

This manual describes about the setting up network servers for system’s network functions.
For information about initial setup for the im4530 Series or im2830 Series, see the Quick Start
Guide.

Conventions

¢ The term “this equipment” in this manual refers to the im4530 Series or im2830 Series.
* The term “e-Filing” in this manual is an abbreviation of “electronic filing”.

Lineup of Our Manuals

Thank you for purchasing the Océ multifunctional digital systems im4530 Series or im2830
Series.

We have provided you with these manuals for the operation of this equipment. Select and read
the manual best suited to your needs.

e Quick Start Guide

This Quick Start Guide describes the initial setup method of this equip-
ment and accessories of this product such as operator’'s manuals and
CD-ROMs.

Operator’s Manual Basic Functions

This Operator’s Manual Basic Functions describes how to use the basic
functions of this equipment mainly focusing on the copying function.
Also this manual contains safety precautions for users to be observed.
Be sure to read it first carefully.

User Functions Guide

This User Functions Guide describes the functions and settings under
the [USER FUNCTIONS] button on the control panel of this equipment.

For Océ and Imagistics Models  (0cé
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Other guides are provided by the User Documentation CD-ROM in PDF files:
0c | P Ui Guide Printer Utility Guide

This Printer Utility Guide explains how to operate and set up the network
functions such as the network scanning function and job management,
using the Printer Utility (Web-based utility) from client computers.

Network Administration Guide

This Network Administration Guide explains the guidelines for setting up
network servers to provide various network services, and troubleshoot-
ing for network administrators.

0c | PriningGuide Printing Guide
This Printing Guide explains how to install the client software for printing
from Microsoft Windows, Apple Mac OS, and UNIX computers, and print
to the equipment.

Scanning Guide

This Scanning Guide explains how to operate the scanning function of
this equipment.

e-Filing Guide
This e-Filing Guide explains how to operate the e-Filing function using
the TWAIN driver, File Downloader and e-Filing web utility.
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Network Fax Guide
This Network Fax Guide explains how to use the network fax function
that enable users to operate fax and internet fax sending from a client
computer via network.

Py FTvE— User Management Guide

This User Management Guide describes how to manage this equipment
using the functions of “Department Management”, “User Management
Setting” and “User Authentication for Scan to E-mail”.

To read manuals in PDF (Portable Document Format) files

Viewing and printing this operator’s manual in PDF files require that you install Adobe Reader or
Adobe Acrobat Reader on your PC. If Adobe Reader or Adobe Acrobat Reader is not installed
on your PC, download and install it from the website of Adobe Systems Incorporated.
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Precautions in this manual

To ensure correct and safe use of this equipment, this operator’s manual describes safety pre-
cautions according to the three levels shown below.

You should fully understand the meaning and importance of these items before reading this
manual.

- Indicates a potentially hazardous situation which, if not avoided, could result
in death, serious injury, or serious damage, or fire in the equipment or sur-
rounding assets.

. Indicates a potentially hazardous situation which, if not avoided, may result in
minor or moderate injury, partial damage of the equipment or surrounding
assets, or loss of data.

Indicates a procedure you should follow to ensure the optimal performance of
the equipment and problem-free copying.

Other than the above, this manual also describes information that may be useful for the opera-
tion of this equipment with the following signage:

Describes handy information that is useful to know when operating the equip-

ment.
| Pages describing items related to what you are currently doing. See these

pages as required.
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Setting up Network Server

This section describes the instructions on how to set up the network servers.

About Network Server SEtUP ... rerrre e s s s e ee s e e e erereereeseenes 12
Setting up Windows Print Server ... e 13
Configuring the WIindows Print SEIVET ............i it 13
Setting up NetWare Print Server..........cccoiimniserr e 15
Setting up the NetWare in Bindery MOde............ooiiiiiiiiiii e 15
Setting up the NetWare in NDS MOGE .........ooiiiiieeiee e et e e s e snaee e 17
Setting up the NetWare in NDPS MOGE ........coouiiiiiiiieeee et 18
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About Network Server Setup

This chapter describes environments that typically include one or more network servers (Novell
NetWare servers and Windows print servers) that will share printing to this equipment. It
describes setting up servers that use IPX/SPX or TCP/IP protocols for communicating with this
equipment. In addition, it includes some guidelines for setting up the DNS server and mail server
to enable the Scan to Internet Fax and Email features, and for setting up the LDAP service using
the Kerberos Network Authentication Service.
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Setting up Windows Print Server

If a Windows NT 4.0, Windows 2000, Windows XP, and Windows Server 2003 computer is con-
nected to this equipment using TCP/IP, it can print directly to this equipment. If the computer
shares the printer over the network; it is acting as a print server for Windows clients. The client
machines print to this equipment by printing to the Windows print server. Printing can then be
monitored and controlled at the Windows print server machine.

The Windows print server can also use AppleTalk protocols for printing to this equipment as an
alternative to TCP/IP. When creating a printer to share with AppleTalk users, do not “capture” the
printer. Capturing the printer forces all users to print to the server rather than directly to the
printer. If you capture the printer, this equipment print connections will not appear in the Mac OS
Chooser.

Configuring the Windows Print Server

To configure a Windows print server to communicate with this equipment, follow these general

steps. More detail is provided in subsequent sections.

* Load the TCP/IP network protocol on the server and configure it with an IP address, subnet
mask, and gateway.

* Make sure the Microsoft TCP/IP printing service is installed, and that the computer is using
Raw TCP or LPR printing.

* On the Windows print server, install the appropriate printer drivers (if necessary) and share
the printer on the network.
P.13 “Installing the Printer Drivers as Shared Printers”

* Configure clients for printing to the printer shared by the Windows print server.
P.14 “Setting up the Clients”

Installing the Printer Drivers as Shared Printers

First, install the Windows printer drivers. The installation instructions in the Printing Guide can
be used for every computer that will print directly and independently to this equipment. However,
if you are an administrator running Windows NT 4.0 Server, Windows NT 4.0 Workstation, Win-
dows 2000 Professional, Windows XP Professional, or Windows Server 2003, you can also cre-
ate a printer and share it with clients on the network. When a printer is shared, clients who are
not able or are not given permission to establish an independent network connection to this
equipment can print through the server.

If you have not installed the printer files on the Windows print server computer, do so now follow-
ing the instructions for Raw TCP or LPR printing in the Printing Guide. Then, or if you have
already installed the printer files on the computer you are using as a Windows print server, see
your Windows documentation for information about sharing the printer.

In addition, the printer files for every Windows version can be installed to the shared printer so
that Windows clients can use the shared printer as a Point and Print printer, which enables cli-
ents to download the appropriate printer driver from the shared printer.

* When installing the printer driver to Windows NT 4.0 clients from the Windows NT 4.0 print
server, please check the “Always spool RAW datatype” box on the Print Processor dialog
box (displayed by clicking the [Print Processor...] button on the General tab of printer proper-
ties dialog box of the shared printer on the Windows NT 4.0 print server).

* When installing the Windows 2000 PCL printer driver to the Windows 2000 server, you must
clear the “Enable advanced printing features” check box on the Advanced tab of the printer
properties dialog box.

Setting up Windows Print Server 13



Setting up the Clients

Each client of a Windows print server is already using a network protocol to communicate with
the server. Each client can print to this equipment if the printer has been shared by a Windows
print server. In that case the client does not have to use the same network protocol to connect to
the Windows print server as the server uses to communicate with the equipment.

To set up printing on client computers, connect to the print server and select the shared printer.
Right-click the printer and select [Open]. When prompted, click [Yes] to have Windows set up
the printer.

After clients have selected the printer, they can choose it from the Print Setup, Page Setup, or
Print dialog box of their application. Clients can change printing options for their own job, but
printer properties are grayed and not available for changing. When a client prints a document,
the job is transmitted to the Windows print server, and from there to this equipment.

The job is listed in the Print Manager on the client computer, and the administrator can track it in
the Print Manager on the Windows print server.

14  Setting up Windows Print Server



Setting up NetWare Print Server

This equipment supports the following Novell printing services:

* NetWare 5.1/6.0/6.5 bindery emulation mode

* NetWare 5.1/6.0/6.5 NDS mode (over IPX/SPX only)

* NetWare 5.1/6.0/6.5 NDPS mode

* NetWare 6.0/6.5 iPrint mode

This chapter provides an overview of how to set up this equipment as a Novell Network Printer,
Print Server, or NDPS Printer Agent. For more detailed information, refer to your Novell docu-
mentation.

Setting up the NetWare in Bindery Mode

You can connect only one directory tree to this equipment. If you need to connect additional Net-
Ware 5.1/6.0/6.5 servers, do so by using bindery emulation, which causes the 5.1/6.0/6.5 server
to behave like, and be accepted as, a NetWare 3.x server.

The file server selected must not be in the same tree as that selected in NDS Setup.

In order to set up the NetWare 5.1/6.0/6.5 server in bindery emulation mode for printing to this
equipment, the network administrator must do the following:
» Edit the network startup file to set the bindery context.
D P.15 “Editing the Network Startup File”
* Configure the print queues, print server, and printer on the file server.
D P.15 “Setting up the NetWare File Server”

Editing the Network Startup File

The following procedures explain how to edit the bindery contexts in the network startup file.

Editing the bindery context

1 On NetWare file server, enter “load install” and press the [Enter]
key.

Select [NCF Files Options] from the menu.
Select [Edit AUTOEXEC.NCF] from the menu.

Search for the file to see if you have a statement similar to the fol-
lowing included:
SET BINDERY CONTEXT=0U=ENG

2N

* If the statement above can be found in the file, the server has a bindery. If this is not
found, enter the statement above and save the file.

5 Restart the NetWare file server.

Setting up the NetWare File Server

The following explains how to set up a NetWare 4.x file server with bindery emulation so that
network users can print to this equipment from their computers, and this equipment can obtain
print jobs from the NetWare server.

Setting up NetWare Print Server 15



For NetWare 5.1/6.0/6.5 in emulation, the NetWare print server and print queue for this equip-
ment are created and configured from NetWare Print Console (PCONSOLE), a NetWare utility
that is stored in NetWare’s PUBLIC directory.

Setting up the bindery with PCONSOLE

1 Start PCONSOLE at the DOS prompt on the computer.

2 Select [Print Queue] from the Available Options menu and press the
[Enter] key.

* The Print Queues window appears.

Press the [Insert] key and enter the print queue name and press the
[Enter] key.

Press the [Esc] key to close the Print Queues window.

Select [Print Server] from the Available Options menu and press the
[Enter] key.

When the message is displayed, press the [Enter] key.

¢ The Print Servers window appears.

~N OO Ok W

Press the [Insert] key and enter a print server name and press the

[Enter] key.

¢ The print server name must be “MFP_[NIC Serial Number]”. You can find the Unit
Serial Number of the equipment on the NIC Configuration list can be printed from the
control panel.

8 Select a created print server name from the Print Servers window
and press the [Enter] key.

e The Print Server Information menu appears.

9 Select [Printers] from the Print Server Information menu and press
the [Enter] key.
¢ The Defined Printers window appears.

1 0 Press the [Insert] key and enter a printer name and press the
[Enter] key.

1 1 Select a created printer name from the Defined Printers window and
press the [Enter] key.

1 2 Highlight the Printer Type field and press the [Enter] key.
* The Printer Type menu appears.

1 3 Select “Other/Unknown” and press the [Enter] key.
1 4 Highlight the Print queue assigned field and press the [Enter] key.

* The NetWare Server\Print Queue window appears.

1 5 Press the [Insert] key and select the created queue from the Avail-
able Print Queues menu and press the [Enter] key.

* Up to 10 queues can be selected. If you created several queues, repeat the operation
to add all queues that are required.

16 Setting up NetWare Print Server
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When more than one queue is added, you must enter the priority
value.

Press the [Esc] key until the Save Changes menu appears.

Select “Yes” and press the [Enter] key.

Setting up the NetWare in NDS Mode

The following explains how to set up a NetWare 5.1/6.0/6.5 file server with NDS so that network
users can print to this equipment from their computers, and this equipment can obtain print jobs
from the NetWare server. More detail is provided in your NetWare documentation.

Setting up the NDS with NetWare Administrator

In NetWare Administrator, select the container object to create the
printer and click the [Object] menu and select [Create].
* The New Object dialog box appears.

In the Class of new object list, select “Print Queue” and click [OK].
* The Create Print Queue dialog box appears.

Select “Directory Service Queue” and enter the name of the print
queue in the Print Queue name field.

Click the browse button at the next to the Print Queue Volume field.
* The Select Object dialog box appears.

Select the volume to create a print queue and click [OK].

Click [Create].
* The print queue is created.

Click the [Object] menu and select [Create].
¢ The New Object dialog box appears.

In the Class of new object list, select “Printer” and click [OK].
¢ The Create Printer dialog box appears.

Enter the printer name, check the “Define additional properties”
option and click [Create].

Display the Assignments window and click [Add].
* The Select Object dialog box appears.

Select a created queue and click [OK].

Display the Configuration window, select “Other/Unknown” at the
Printer Type drop down box and click [OK].

* The printer is created.

Click the [Object] menu and select [Create].
¢ The New Object dialog box appears.

In the Class of new object list, select “Print Server” and click [OK].
* The Create Print Server dialog box appears.

Setting up NetWare Print Server 17



1 5 Enter the print server name, check the “Define additional proper-
ties” option and click [Create].
* The print server name must be “MFP_[NIC Serial Number]”. You can find the Unit
Serial Number of the equipment on the NIC Configuration list can be printed from the
control panel.

1 6 Display the Assignments window and click [Add].
* The Select Object dialog box appears.

1 7 Select a created printer and click [OK].

1 8 Click [OK] to close Assignments window for the print server.
¢ The print server is created.

Setting up the NetWare in NDPS Mode

This equipment supports printing over NetWare 5.1/6.0/6.5 networks running either the TCP/IP
protocols or the IPX protocol. For pure IP printing, this equipment takes advantage of features in
NDPS (Novell Distributed Print Services).

An administrator can use either Novell Printer Gateway or Océ NDPS Gateway to set up the
NetWare server in NDPS mode.

D P.18 “Setting up NDPS Using Novell Printer Gateway”

) P.22 “Setting up NDPS Using Océ NDPS Gateway”

Setting up a NetWare environment correctly requires the presence and active cooperation of the
Novell network administrator. You must have administrator privileges on the network to create
new NDPS objects.

Setting up NDPS Using Novell Printer Gateway

NDPS is not like the earlier queue-based versions of NetWare printing. Instead, you use an
NDPS Manager and a Printer Agent, which control the tasks previously handled by a print
queue, print server, and spooler. You can also make the printer driver available for clients to
download from Windows client computers.

Before configuring the NetWare file server in NDPS mode, please confirm followings:

¢ For NetWare 5.1, the Support Pack 8 and Novell Gateway version 2.1.6 or later with
ndps3sp2c are installed.

* For NetWare 6.5, the Support Pack 5 and Novell Gateway version 3.00 or later with
ndps3sp2c are installed.

* Make sure you have a valid IP address for this equipment and for any computers that will
print to it (when used in the TCP/IP network).

* In the equipment setup, enable TCP/IP and enter the IP address, Subnet mask, and Gate-
way address for this equipment (when used in the TCP/IP network).

Setting up the NDPS with NetWare Administrator

In NetWare Administrator, select the container object to create the
printer and click the [Object] menu and select [Create].
* The New Object dialog box appears.
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Select “NDPS Broker” and click [OK].
* The Create NDPS Broker Object dialog box appears.

Tip
If the NetWare file server has been installed as supporting the NDPS service, the NDPS
Broker is created as default. In this case, you can use the default NDPS Broker.

Specify the “NDPS Broker Name” and “RMS Volume” options, and
click [Create].
* The NDPS Broker is created.

Click the [Object] menu and select [Create].
¢ The New Object dialog box appears.

Select “NDPS Manager” and click [OK].
* The Create NDPS Manager Object dialog box appears.

Specify the “NDPS Manager Name”, “Resident Server”, and “Data-
base Volume” option, and click [Create].
* The NDPS Manager is created.

After creating the NDPS Broker and NDPS Manager, please load the
NDPS Broker and NDPS Manager by entering the following com-
mands in the Console screen of the NetWare server.

load broker [Created NDPS Broker Name]
load NDPSM [Created NDPS Manager Name]

Double-click the NDPS Broker object that you created.
¢ The NDPS Broker dialog box appears.

Click [Resource Management (RMS)].
Click [Add Resources...].

* The Manage Resources dialog box appears.

If the [Add Resources...] button is disabled, make sure that the broker is loaded. This
button will be enabled only when the broker is loaded.

Select the applicable OS icon in the “Resource Types” list, and
click [Add...].
¢ The Add Resources dialog box appears.

Click [Browse].

¢ The Select Printer Driver dialog box appears.

The [Browse] button may not be available according to the Support Pack version. If the
[Browse] button is disabled, specify “/DISABLETLSMGR” option when starting the
nwadmin32.exe.
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1 3 Insert the Client Utilities CD-ROM into the CD-ROM drive.

* When inserting the Client Utilities CD-ROM, the installer may automatically start.
Click [Cancel] to exit the installer and continue the operation.

Locate the directory where the printer driver for your Windows ver-
sion is located, select the INF file.

* When you want to install the PCL6 printer driver for Windows 98/Me, locate "[CD-
ROM drive]:\Client\9X_ME\PCL6\<language>".

¢ When you want to install the PS3 printer driver for Windows 98/Me, locate "[CD-ROM
drive]:\Client\9X_ME\PS\<language>".

* When you want to install the PCL6 printer driver for Windows NT 4.0, locate "[CD-
ROM drive]:\Client\NT\PCL6\<language>".

* When you want to install the PS3 printer driver for Windows NT 4.0, locate "[CD-ROM
drive]:\Client\NT\PS\<language>".

* When you want to install the PCL6 printer driver for Windows 2000/XP, locate "[CD-
ROM drive]:\Client\W2K_XP_2003\PCL6\<language>".

¢ When you want to install the PS3 printer driver for Windows 2000/XP, locate "[CD-
ROM drive]:\Client\W2K_XP_2003\PS\<language>".

15 Click [OKI.

* Returns to the Add Resources dialog box.

16 Click [OKI.

* Returns to the Manage Resources dialog box.

1 7 Repeat the procedure from Step 10 to Step 15 to add all printer driv-
ers for the applicable OS.

1 8 Click [OK] to close the Manage Resources dialog box.
* Returns to the NDPS Broker dialog box.

1 9 Click [OK] to close the NDPS Broker dialog box.

20 Click the [Object] menu and select [Create].
* The New Object dialog box appears.

21 Select “NDPS Printer” and click [OK].
* The Create NDPS Printer Object dialog box appears.

22 Specify the “NDPS Printer Name” option, select “Create a New
Printer Agent”, and click [Create].
* The Create Printer Agent dialog box appears.

When setting up the NDPS in the iPrint mode, do not enter more than 7 characters for the
“NDPS Printer Name” option. If you enter more than 7 characters for the “NDPS Printer
Name” option, the default watermarks will not be registered when installing the printer
drivers in Windows 98/Me.

23 Specify the “Printer Agent (PA) Name” and “NDPS Manager Name”
option. Then select “Novell Printer Gateway” in the “Gateway
Types” list and click [OK].
¢ The Warning dialog box appears.
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Click [OK].

* When it finishes initializing, the Information dialog box appears.

Click [OK].

* The Configure Novell PDS for Printer Agent dialog box appears.

Select “((NONE))” in the “Printer Type” list and select “Novell Port

Handler” in the “Port Handler Type” list. Then click [OK].
* The Configure Port Handler for Printer Agent dialog box appears.

Continue the procedure according to which connection type to be
used.

P.21 “Configuring the LPR connection in the TCP/IP network”
1 P.21 “Configuring the queue based connection in the IPX/SPX network”

Configuring the LPR connection in the TCP/IP network

1

~No O A~ W

8

In the Configure Port Handler for Printer Agent dialog box, select
“Novell LPR Printer Gateway (SNMP)” (or “Remote (LPR on IP)”)
and click [Next].

Enter the IP address of this equipment in the “Host Address” field,
and click [Finish].

* It takes about 60 seconds to load the Printer Agent. After it finishes loading the
Printer Agent, the Select Printer Drivers dialog box appears.

Select the printer drivers to be installed in the “Printer Drivers” list
at each OS tab, and click [Continue].

¢ The Information dialog box appears.

Click [OK].

* |t takes about 60 seconds to complete the creation of the NDPS Printer object.

Double-click the NDPS Printer object that you created.
¢ The NDPS Printer dialog box appears.

Click [NDPS Remote Printer Management].

Check the “Install to workstation in this container” and click
[Update].

Click [OK] to close the NDPS Printer dialog box.

Configuring the queue based connection in the IPX/SPX network

1

In the Configure Port Handler for Printer Agent dialog box, select
“Forward Jobs to a Queue” and click [Next].
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2 Enter the NDS queue name in the “Queue Name” field and the user
name in the “Queue User Name” field. Then click [Finish].
* The Select Printer Drivers dialog box appears.

The NDS queue must be created.

Select the printer drivers to be installed in the “Printer Drivers” list
at each OS tab, and click [Continue].

¢ The Information dialog box appears.

Click [OK].

* |t takes about 60 seconds to complete the creation of the NDPS Printer object.

Double-click the NDPS Printer object that you created.
* The NDPS Printer dialog box appears.

Click [NDPS Remote Printer Management].

Check the “Install to workstation in this container” and click
[Update].

8 Click [OK] to close the NDPS Printer dialog box.
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Setting up NDPS Using Océ NDPS Gateway

The Océ NDPS Gateway mechanism employs several components, notably the NDPS Man-
ager, NDPS Broker, and NDPS Printer Agent. The following figure illustrates the communication
flow between these objects.

NetWare File Server

Administrator End User

The NetWare printer can be discovered in two ways:

e The printer is automatically discovered by the Océ NDPS Gateway.
You add it manually to the NDPS Manager, which resides on the same NetWare file
server as the Océ NDPS Gateway.

When an end-user attempts to add a NDPS printer, the client que-
ries the NDPS Brokers to identify all available NDPS printers.

22 Setting up NetWare Print Server



3 The NDPS Broker responds with a list of NDPS Printer Agents. The
user selects a Printer Agent and the Océ NDPS Gateway down-
loads the appropriate driver to the user’s desktop.

4 When the client workstation is ready to print, it sends the print job
to the Printer Agent, which is a virtual printer image created in the
NDPS network.

5 The NDPS Manager then passes the print jobs to the Océ NDPS
Gateway.

6 The Océ NDPS Gateway issues the printing commands to the
printer.

— Installing the Océ NDPS Gateway

Considerations and Limitations

The Océ NDPS Gateway can be installed in servers running NetWare 5.1 with service pack
3A (3.0.1) or higher or NetWare 6.0/6.5. A self-extracting executable file contains both the
Océ NDPS Gateway and a NetWare Admin Snap-in component that are necessary to sup-
port NDPS printing on the equipment.

The NDPS Manager can drive several Gateways simultaneously. The Océ NDPS Gateway
does not interfere with other manufacturer’s Gateways.

The Océ NDPS Gateway supports multiple printers; one printer can also be split between
several Gateways to balance the work load.

Both NDPS and non-NDPS users can share the same printer.

The Océ NDPS Gateway supports network configurations that are based on both a server
and the Windows operating system.

Prerequisites

Install NDPS in the NetWare servers. NDPS comes with NetWare 5.1, but it is not installed auto-
matically. The NDPS install program extends the NDS schema for three NDS objects:

NDPS Manager
NDPS Broker
NDPS Printer Agent

Installing the Océ NDPS Gateway

1 Insert the Client Utilities CD-ROM into the CD-ROM drive on the
administrative workstation.

2 Copy “tndps.exe”, the self extracting executable file from the CD-
ROM to the workstation. Double-click the file to launch the
InstallShield setup program.

3 Follow the Setup Wizard’s prompt to supply the server volume or
Browse to select a mapped drive.

4 Click [Next] to proceed with installation. When the NDPS Gateway
and NetWare snap-in components have been installed, you can
configure the equipment as an NDPS object.
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— Setting up the equipment as an NDPS Object
Considerations and Limitations

This equipment should be automatically discovered by the Océ NDPS Gateway. If not, manually
create a new NDPS Printer Agent. (EJ P.24 “Create a Printer Agent”)

Prerequisites

1 Load “NWADMN32.EXE” on the administrator workstation to
launch the NetWare administration program.

2 Determine the Tree or Context under which to install the NDPS
printer agent.

3 Verify that both a NDPS Manager and Broker object exist at this
level. If not, create them.

4 Add drivers to the NDPS Broker. They can then be selected from
the drivers list and associated with the Printer Agent.

Add Drivers to the NDPS Broker

Launch NWAdmin.

Double-click the Broker icon.

Click [Resource Management (RMS)].
Click [Add Resources].

Select the applicable system: the Windows 98/Me/2000, Windows
NT or Windows XP operating system. Click [Add].

Click [Browse] to locate the driver's .inf file on either the distribu-
tion CD-ROM or a shared network location.

Click [OK].
Now, when you create a Printer Agent, you can associate the drivers by selecting them
from the list of drivers managed by the broker.

N OO OARAWN-

Create a Printer Agent

1 Right-click anywhere within the Parent Level (Tree or Context under
which the NDPS Printer Agent is to be installed) and then choose
[Create].
¢ The New Object dialog box appears.

2 From the “Class of New Object” list box, select “NDPS Printer” and
click [OK].
* The Create NDPS Printer dialog box appears.

3 Enter the NDPS Printer Name, then click [Create].
* The Create Printer Agent dialog box appears.
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4 Enter the NDPS Manager name or click [Browse] to locate it.

5 Select “Océ NDPS Gateway Configuration” in the “Gateway types”
list, then click [OK].
* The Gateway Configuration dialog box appears.

6 Select the NDPS Gateway Printing Mechanism and click [Next].
The configuration dialog that appears depends on the printing mechanism you choose. A
description of the configuration settings for each option follows. When you finish
configuring the Printer Agent, proceed to "Select Drivers" on page 25.
) P.25 “LPR on IP”
[ P.25 “Queue-Based (NDS Printer Agent)”

LPRon IP

If you select the LPR Gateway configuration option, the Remote-LPR Printer Configuration dia-
log box opens:

1 Enter the IP Address of the equipment and then click [Finish].

To confirm your choice, click [Yes].
When the update is complete, you can proceed to "Select Drivers" on page 25.

Queue-Based (NDS Printer Agent)

If you select the Queue-based (NDS Printer Agent) option, the Configure Printer Agent dialog
box opens:

1 Either type in the Advertising Print Server name, or click [Search] to
automatically locate print server information and choose a device
name from the drop-down list.

Once a server is selected, the remaining fields are populated with the associated data.

2 Check the “Manual Configuration” checkbox to edit the default data
or if the device is not automatically located.

IPX Address — Enter the 8 digit IPX Network Address (NET) of the Novell network in the
first field, and enter the MAC Address of the device in the second field.

Print Server Name — Enter the Novell Network Print Server Name of the device.
Password — Enter the password for the Novell Network Print Server if required.
Printer Name — Enter the “<Novell Network Print Server Name of the device>_PTR”.
NDS Volume for the Print Queue — Enter the

“<Novell Server Name>_<Volume>.<Context>" of the object.

3 Click [Finish].

To confirm your choice, click [Yes].
When the update is complete, proceed to "Select Drivers" on page 25.

Select Drivers

After you create a Printer Agent, configure the options. When the update completes, the Select
Printer Drivers dialog box opens:

1 Select the appropriate operating system tab.
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2 Select the printer drivers to be automatically downloaded to users’
workstations when they select the new Printer Agent.

3 Select all desired drivers and then click [Continue].
A message box opens, listing the selected drivers:

4 Click [OK] if the selections are correct or click [Cancel] to return to
the Select Printer Drivers dialog and modify your selections.

NDPS Printer Agent setup is complete. The new Printer Agent now appears in the list of
NDPS objects.

— Removing NDPS Components

1 Use the NWADMIN utility to delete all Océ NDPS printer and print
agents you created.

2 Delete the following files using either Windows Explorer or MS-DOS
operating system commands. Check that the files are not in use
before deleting them.
SYS:\SYSTEM\TAGATE.NLM
SYS:\SYSTEM\TAPAP.NLM
SYS:\SYSTEM\TACON.NLM
SYS:\SYSTEM\TALIB.NLM
SYS:\SYSTEM\TACFG.PDO
SYS:\SYSTEM\NLS\4\TAGATE.MSG
SYS:\SYSTEM\NLS\A\TACON.MSG
SYS:\SYSTEM\NLS\A\TALIB.MSG
SYS:\SYSTEM\NLS\A\TACFG.MSG
SYS:\SYSTEM\NLS\A\TAPAP.MSG
SYS:\SYSTEM\NLS\4\TACFG.HLP
SYS:\SYSTEM\NLS\A\TACON.HLP
SYS:\SYSTEM\NLS\A\TALIB.HLP
SYS:\PUBLIC\WIN32\TASNAPIN.PC2
SYS:\PUBLIC\WIN32\TACFG.PD2
SYS:\PUBLIC\WIN32\Oce.INI
SYS:\PUBLIC\WIN32\TASNMP.DLL
SYS:\PUBLIC\WIN32\NLS\ENGLISH\TARES.DLL
SYS:\PUBLIC\WIN32\NLS\ENGLISH\TACFGRES.DLL
SYS:\PUBLIC\WIN32\NLS\ENGLISH\SC2_MSG.DLL
SYS:\PUBLIC\WIN32\NLS\ENGLISH\HLP25632.DLL
SYS:\PUBLIC\WIN32\NLS\ENGLISH\ROBOEX32.DLL
SYS:\PUBLIC\WIN32\NLS\ENGLISH\SC3_MSG.DLL

Setting up the NetWare in iPrint Mode

This equipment also supports the Novell iPrint.

Using the iPrint system, you can set up the printer that can be accessed using URL from client
computers. The iPrint system is based on the NDPS architecture so that you must have NDPS
installed and configured in the NetWare 6.0/6.5 server.

Before configuring the NetWare file server in NDPS mode, please confirm followings:
* The NDPS Broker, NDPS Manager, and NDPS Printer must be created.
[ P.18 “Setting up the NDPS with NetWare Administrator”
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¢ The Novell iManager must be installed.

For more information to install the Novell iManager, please see the documentation for the
Novell iManager that is provided by Novell, Inc.

In order to set up the iPrint system, the network administrator must do the following:

1.

2.

3.

Installing iPrint

P.27 “Installing iPrint”

Enabling the DNS on the Printer Services Manager

) P.27 “Enabling DNS on the Printer Services Manager”
Enabling iPrint service

3 P.27 “Enabling iPrint Service”

Installing iPrint

1 Click [Novell] in the GUI screen of NetWare and select [Install].
2 Click [Add].
Tip
If the iPrint/NDPS is displayed in the list, iPrint has already been installed during the

installation of NetWare. In that case, you do not have to operate the installation for iPrint.

3 Insert the NetWare Operating System CD-ROM into your CD-ROM

drive.

4 Select the “PRODUCT.NI” file that is located in the root of the CD-

ROM, and click [OK].
5 Follow the prompts to install iPrint/NDPS.

Enabling DNS on the Printer Services Manager

Before enabling DNS for the Printer Services Manager, you should add the DNS name for the
Printer Services Manager to the DNS server.

After you add the DNS to the DNS server, follow the steps below to enable the DNS on the
Printer Services Manager.

At the server console, enter the following syntax.
NDPSM <NDPS Manager Name> /dnsname=<NDPS Manager DNS Name>

Enabling iPrint Service

After enabling DNS on the Printer Services Manager, enable the iPrint Service using the iMan-
ager.
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* To do this, iManager must be installed on your NetWare server. For information about install-
ing iManager, see the documentation for iManager that is provided by Novell, Inc.
* You must use a supported browser to access iManager. The supported browsers vary
depending on the version of iManager that you installed.
For iManager 1.5.2
- Microsoft Internet Explorer 5.5 or later (Recommended)
- Netscape 6.2 or later
For iManager 2.0.x
- Microsoft Internet Explorer 6 SP1 or later (Recommended)
- Netscape 7.1 or later
- Mozilla 1.4 or later

1 Enter the URL “https://<IP address>:2200” in the address bar of
your browser, and click the iManager link for the NetWare server
under eDirectory iManager.

Enter the user name and password to log in to iManager.

Click [iPrint Management] in the Contents Panel and click [Manage
Printer].

Select the printer that you created for the equipment.
Click [Client Support] and click [IPP Support].
Check the “Enable IPP Access” check box.

If you want to secure printing, check the “Require Security” check
box.

* When the “Require Security” option is enabled, users must be authenticated to eDi-
rectory using the user name and password.

~Nooakh WN

Click [Apply] and [OK] to save settings.
¢ The IPPSRVR.NLM is automatically loaded.
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Setting up DNS and Mail Servers

This section describes how to set up the DNS server and Mail server for the Internet connection.
The figure illustrates a general network environment for Internet connection from a local area
network.

Global IP Address

e L o

192.168.0.1
192.168.0.2 192.168.0.3 192.168.0.3
192.168.0.4
. 192.168.1.1
DNS Server Email Server Proxy Server
192.168.1.2 192.168.1.3 192.168.1.4

As shown in the figure above, a local area network usually consists of several segments: one
connects to the router directly (and is assigned a Global IP address) and others are for client
computers.

To enable Internet access from the local area network, the router must be assigned a Global IP
Address. In the above figure, the Private IP addresses have been assigned to all devices in the
local area network, and the router maps between the Private IP addresses and Global IP
Addresses using the NAT, Network Address Translation. This gives clients and servers access
to the Internet through the router.

Regarding the security, it is preferred to place this equipment in a different segment from the
router that connects to the Internet.

Also, in order to enable Internet communication from the device in the local area network, the
Domain Name Service is used. In the Internet, the DNS server specifies the domain name
related to the global IP address of the servers. To recognize the domain names in the Internet,
the domain names must be registered in both the DNS server in the Internet, which is managed
by the public DNS organization, and the DNS server in the local area network where the remote
devices are actually located. To configure the DNS server in your local area network, create fol-
lowing records in the DNS server:

* DNS zone name (i.e. “ifax.com”)

* Host name of the DNS server (i.e. “nshost”)

* NS record to specify the DNS server in your zone (i.e. “nshost.ifax.com”)
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To send the Internet Fax and Email documents from this equipment, and receiving the Internet
Faxes from the Internet, you must configure the DNS server and mail servers properly.

Tips for configuring the DNS server and mail servers for this equipment features are described
in the following sections:

3 P.30 “Tips of Setting up the DNS and Mail Servers for Email”

P.31 “Tips of Setting up the DNS and Mail Servers for Internet Fax”

P.31 “Tips of Setting up the DNS and Mail Servers for Offramp Gateway”

* When using DDNS and the IP address is assigned using DHCP, enable “006 DNS Servers”
and “015 DNS Domain Name” in the DHCP Server’s Scope Options or Server Options.

=10/ x|
| acion wew || & =+ | B(m| BB 2 || |

Tree | Server Options
DHCP Option Name [¥endor [ value

= wean0s-ent dominos ldré4.Iocal | 51006 DN Servers Standard  172.16.16.2
.45 Server Options &fs] 015 DS Domain Name  Standard  test.ad.local

‘<| | »lsd | | ‘ i

* When using DDNS, make sure the “Allow dynamic updates?” option is set to “Yes” (for Win-
dows 2000 Server) or “Nonsecure and Secure” (for Windows Server 2003) for the Forward
Lookup Zones and Reversed Lookup Zones. If setting of Windows Server 2003 is “Secure”
mode or “None” for this DDNS function, you need to add the equipment’s host name manu-
ally in the Forward and Reversed Lookup Zone.

dominab.ldméjlocal Properties 2lx 2l
wINS | Zone Transfers | Secuity | NameServers | WINSR | ZoneTransfers |
General | StatofAuthoity[S0A] | MameServers General | Start of Autharity [S04)
Status.  Runing Pauss Status: Funring T
Type:  Active Directaryintegrated Change. Type:  Priman Change

Data is stored in Active Directory. Zone file name:

[16.172.in-addh.arpa. dns

Allow dynamic updates?

| Allow dynamic updatss? s B

To set aging/scavenging properties, click Aging. Aging. To set aging/scawenging properties, click Aging. Aging

Ok | Cancel Apply 0k | Cancel Aprly

Tips of Setting up the DNS and Mail Servers for Email

The Email transmission from this equipment works same as sending an Email message from a
client computer. To do this, you configure the DNS servers and mail servers.

Because the Email is one way transmission forwarding to the Internet, only the SMTP server is
required for the transmission. To enable sending a Scan to Email document to the Internet, the
DNS server should be configured to enable accessing the Internet using the DNS service.
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Tips of Setting up the DNS and Mail Servers for Internet Fax

The Internet Fax transmission enables sending an Internet Fax and receiving an Internet Fax
from other Internet Fax devices.

Because the Internet Fax transmission is same as the Email transmission, you are ready to use
this feature if you have already configured the Email system in your network.

In order to configure the Email system, you must have the DNS, SMTP, and POP3 servers.

In the DNS server, you must additionally create the MX record of the server that the SMTP
server is activated (i.e. “mxhost.ifax.com”), and the host name of the server to add the host
name of the SMTP server (i.e. “mxhost”). This enables to receive all Emails that are sent to
“@ifax.com” to the SMTP server and stored in the mailboxes. Then this equipment requests to
the POP3 server to retrieve new Internet Faxes from the mailbox.

Tips of Setting up the DNS and Mail Servers for Offramp Gateway

When you enable the Offramp Gateway transmission, this equipment must be configured to
receive Emails in the SMTP transmission.

However this equipment does not have full SMTP server functionality so it cannot retrieve
Emails from the Internet by itself. For this equipment to receive Emails in SMTP transmission
from the Internet, the Emails must be retrieved by the another SMTP server first and then
routed to this equipment.

In order to enable the transmission, you must additionally create the MX record of the server that
the SMTP server is activated (i.e. “mxhost.ifax.com”), and the host name of the server to add the
host name of the SMTP server (i.e. “mxhost”). In addition, create the host name of this equip-
ment (i.e. “mfp00c67861”). Then, you must configure the SMTP server to route Emails, whose
domain name is “mfp00c67861.ifax.com,” to this equipment so that this equipment can receive
Emails using the SMTP protocol.
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Setting up LDAP Authentication Service

When you want to enable the LDAP Authentication with Kerberos, you have to configure the net-

work as described below:

* Configure DNS Forward and Reverse Lookup Zones.

* If you want to use LDAP Authentication with Kerberos to Windows server, it is necessary to
configure Kerberos.

¢ Synchronize the time of the equipment and the LDAP server.

* Configure LDAP, DNS, and DDNS Sessions on the equipment.

* Configure Directory Service on the equipment.

This section describes how to set up the LDAP service for a Windows based domain controller
environment.

When LDAP Authentication fails

When the LDAP Authentication fails, please check the followings:

* Make sure that the date and time of the equipment and the LDAP server is synchronized.
* Make sure that the Forward and Reverse Lookup Zones are correctly set.

* Make sure that the Kerberos Principal Name is correctly set.

* Make sure that the LDAP Service in Printer Ultility is correctly set.

¢ Make sure that the option of DHCP server “015 Domain Name Server” is set correctly.

Configuring DNS Forward and Reverse Lookup Zones

For the LDAP Authentication environments:

1. Make sure Active Directory is installed in Windows 2000 Server or Windows Server 2003.

2. Enter the host name, domain name, and IP address of the Active Directory Server and this
equipment in the Forward Lookup Zones of the DNS Client.

A -8l
| 2 Console  window Help ‘;lilﬂ
| adion tiew |J<:=- -b||>< FEHB| 2
Tree | Hame [ Type [ Data |
A%-.DNS r_klimsdcs
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(ISR oo e locl 2 _udp

O _medes €] (sme as parent Folder)  Start of Authority (28], w2000s-enl dominos. ldméd.local., ad...
L3 sites (same as parent folder)  Mame Server w2000s-en1 . dominos.ldméj Jocal,

0 ke

[ R =T W2000s-en1 Host 172.16.16.,138
23 Reverse Laokup Zanes MFP-00000176 Hast 172.16.16.177
2 172,16, Subret
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- The server settings in the example above have the following setup:
IP Address: 172.16.16.138
Host Name: w2000s-en1
Domain Name: domino6.ldmj6.local
- The MFP settings in the example above have the following setup:
IP Address: 172.16.16.177
Host Name: MFP-00000176
Domain Name: domino6.ldmj6.local
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3. Enter the IP address and domain name of the equipment in the Reverse Lookup Zones of
the DNS Client.

o P [=
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4. Itis necessary to enter “user name”+@+"domain name” into the User field in the Active
Directory as registration of the Kerberos Principal Name.

- Run the Active Directory Users and Computers and click the [View] icon and select
[Advanced Features].
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Security Group .. Designated sdministrators...
T T Securty Growp ., Al werkstaions and serve...
Sacurity Group . All domain contrallers in th...
Customize. . Security Group . Al domain guests
 [fEbovenUsers Security Group .. All domain users
T Enterprise Admins  Security Group ... Designated administrators...
€TGroup Palicy Cre...  Security Group ... Members in this group can...
Guest User Built-in aceaunt for guest ...
€} 1USR_W20005-ENT  Liser Built-in account For anony...
€} LWAM_W20005-...  User Built-in aceaunt for Intern...
Ekebtat User Key Distribution Center Se..,
TRAS and 1AS Ser...  Security Group ... Servers in this group can ...
€T 5chems Adrins Security Group ... Designated administrators. ..
7 TsinternetUser User This user account is used ...
N — |
Enables/disables advanced features and objects
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- Right-click a user that you want to enable the Kerberos authentication, and select [Name
Mappings...].
The [Name Mappings...] command does not displayed if you do not select [Advanced
Features] in the [View] icon.

RI=IE]
| <5 consols  window  Help [T

[ woo | = 0@ *EhD 2 cBbTSE |

Tree | Users 19 objects

[&5 puctive Directory Users and Compute | Hame: [Tope [ Description ]

124 dominos ldméj.Jocal Adlministrator User Buit-in account for admiri...
(22 Buikin € CortPublishers  Security Group ... Enterprise certification an. ..
(22 Computers €72 Onsidrins Security Group ... DNS Administrators Group
(&1 Domain Controllers €TonsUpdateProxy  Security Group ... DNS clients who are permi...
(3 ForeignSecurityPrincipals !ﬁDnmain Adrins Security Group ... Designated administrators. ..
(3 LestandFound € Domain Computers  Security Group ... All workstations and serve...
(3 System €T Domain Contrallers  Security Group ... All domain controllers in th...

3 Users €72 Domain Guests Security Group ... All domain quests
€T Domain Users Security Group ... Al domain users

€ Enterprise Admins  Security Group ...  Designated administratars. .
€7 Group Policy Cre...  Security Group ... Members in this group can. .

Guest User Built-in account for guest ...
1USR_W20005-EM1 User Buit-in account for anony...
€ LM _W2000s-,. User Built-in account for Intern, .
skrbtat User Key Distribition Center Se...

€TiRAS and IAS Ser...  Security Group ...  Servers in this group can ...
€T 5chema Admins  Security Group ... Designated admiristrators. .

Copy..
Telnternetliser  pdd members to a group...

ccount is used ...

Disable Account

Reset Password, .,

q _;I Move...
IMaps certificates for this account, e o FeER
Send mail

- Enter “user name”+@+"domain name” in the field. For “user name”, enter the full name
of the selected user.

Add Kerberas Principal Name X|

Kerberos principal name:

test usen@dominob ldmbi lacal

5. When the IP address is assigned using DHCP, enable “006 DNS Servers” and “015 DNS
Domain Name” in the DHCP Server’s Scope Options or Server Options.

P [=TE
| action Yiew |J & = | |2 |J &
Tree | Server Options
R Option Name [ vendor [ walue
7 3 we0n0s-en1 dominos.kdméj. local [« DS Servers Standard  172.16.16.2
“28 Server Optians afg] 015 DS Domain Name  Standard  testad Jocal
4 | 3| K1} | |

34 Setting up LDAP Authentication Service



6. Make sure that the Dynamic update is enabled from DDNS for the Forward Lookup Zones.
- Right-click the domain in the Forward Lookup Zones and select [Properties].

= DNS

Y =]
| 2 Console  Window Help [INETES |
H;tinn yiew“c:-b\\x‘@ |
Tres | Mame [ Tvpe [ Data I
:_:LI DS D_msdcs
= weooos-gnt 1 _sies
£ Forward Lookup Zanes O op
oEl =
msdes  Jpdate SErverDataRile oo folder) Start of Adth...  [22], w2000s-ent.domings.Jdmslocal., ad...
D sites | Reload parent Folder) Name Server  w2000s-en!.domingé.ldméd.local.
0 e =zl parent folder) Host 172.16.101.227
8 udp | Newplss.., nil Host 172.16.101.227

-0 Reverse Looky Mew Mail Exchanger...
2 172,165 Mew Domain...
L1 Mews Delegation. .
Other New Records...

Yiew 5
(Opens praperty shest For il New Window from Here
Delete

Refresh

ExportLi

- Make sure the “Allow dynamic updates?” option is set to “Yes” (for Windows 2000
Server) or “Nonsecure and Secure” (for Windows Server 2003).

dominob.ldm6j.local Properties i x|
WINS | Zone Transfers | Secuiy |
Generdl | Siatofdutherty (5041 | Mame Servers

Status:  Funning Pause
Type:  Active Ditectory-intearated Change.

Diata is stored in Active Directory.

Allow dynamic updates?

To set aging/scavenging propsties, dlick Aging, Aging...

0K | Cancel Apply

If setting of Windows Server 2003 is “Secure” mode or “None” for this DDNS function, you
need to add the equipment’s host name manually in the Forward Lookup Zone.
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7. Make sure that the Dynamic update from DDNS for the Reverse Lookup Zones.

Right-click the domain in the Forward Lookup Zones and select [Properties].

= DNS

2 console  Window  Help

1o/ xI|
[IETE|

J
I

Action  View |J¢=-o\\x\@

Tree |

EAT
= waooos-em
- Forward Lookup Zanes

_msdcs

Marme:

[ Tvpe

[ Data [

(3 _msdes
(1 _sites
_tep
1 _udp
{same as parent Folder)

Stark of Auth...

Mame Server
Host
Host

[22], w2000s-en1 . dominos.|dméj.local., ad...
w2000s-en1 dominos Jdmé}. ocal.
172.16.101.227

172.16.101.227

L _sites (same as parent Folder)
0 e (same as parent Folder)
0 _udp (€] w2000s-8nt
- Reverse Lookup Zanes
=
10;  Update Server Data File
Reload
Mew Painter...
New Alss...

Opens property sheet |

New Domain. .
Nt Delegation..
Other New Records...

Mews Window From Here

Delete
Refresh

Make sure the “Allow dynamic updates?” option is set to “Yes” (for Windows 2000

Server) or “Nonsecure and Secure” (for Windows Server 2003).

172.16.1.% Subnet Properties 2=l
MameSevers | WINSR | ZoneTransfers |
General Start of Authority [SOA)
Status:  Running T
Type:  Primary Change
Zone file name;
[16.172.in-addr.apa.dns
Allow dynamic updates? es -
To set aging/scavenging properties, click Aging. Aging
0K | Cancel Aapl

If setting of Windows Server 2003 is

“Secure” mode or “None” for this DDNS function, you

need to add the equipment’s host name manually in the Reversed Lookup Zone.

Configuring the Equipment Using

Printer Utility

From Printer Utility, you must configure the Date & Time, LDAP Session, DNS Session, DDNS

Session and others.

1.
eral] page.

Date & Time

Set the same time and date as the LDAP Server in the [Administration] -> [Setup] -> [Gen-

|2006 | [October |21 Jm2 oo

|(GMT+12:DD) Wellington, Auckland
Date Format

daylight maode

[
IMMIDDIYY 'l
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2. Set the LDAP Session, DNS Session, and DDNS Session in the [Administration] -> [Setup] -
> [Network] page.

[LDAP Session] Set to Enable.

[DNS Session] Set to Enable and specify the DNS server address.
[DDNS Session] Set to Enable and specify the host name and domain name.
LDAP Session |
Enable LDAP [Enatle
Enahble S5L [Disatle

Go to top of this page

DMNS Session
Enable DRSS Enable
Primary DMNS Server Address 0.0.0.0
Secondary DNS Server Address 0.0.0.0

Go to top of this page

DDMS Session

Enable DDMNS Enable
Host Mame hFP-04995520
Domain Mame

3. Configure the following settings as required.

- The directory service needs to be registered in the [Administration] -> [Maintenance] ->
[Directory Services].

- When you configure the User Authentication for Scan to Email to obtain the From
Address from the directory service, the correct LDAP attribute for “user name” must be
specified. For example, the attribute of “user name” is typically “cn” for Windows 2000
Server and Windows Server 2003, and it is typically “uid” for the Novell Directory Service.
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Setting up Role Based Access Control

When you enable the Role Based Access Control for the User Management Setting, you must
configure the Role Based Access Control in the LDAP server.

When you enable the Role Based Access Control, you can restrict the operations for each regis-
tered user using LDAP server.

To manage the Role Based Access Control, add the following schema setting in each user infor-
mation registered in the LDAP server.

oID 1.3.6.1.4.1.1129.2.100.1.1
Attribute Name eBMUserRole
Attribute Type Unicode string
Max 256
Value C: Copy
Em: Email
Fl: Save as file
P: Print
B: Store to e-Filing
Fx: Fax
iF: Internet Fax

FC: Address Book registration
Template registration
User settings (can be set from the [USER] button in
the [USER FUNCTION] button

*: All above functions

Also you can use the following prefixes:
+: Prefix for permitting
- Prefix for prohibiting

Example:

eBMUserRole = “+C+Em+F|+Fx+iF”
Copy, Email, Save as file, Fax, and Internet Fax are allowed for the user.

eBMUserRole = “-Em-Fx”
Others than Email and Fax are allowed for the user.

eBMUserRole = “ “
All functions except the administrative functions are allowed for the user.

eBMUSerRole — wkn
All functions except the administrative functions are allowed for the user.
(Same as eBMUserRole = “ )

¢ “+”and “-” cannot be entered in the same user.
¢ ““>must be entered into a head.
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Configuring Role Based Access Control for Windows Server 2003

This section describes how to set up the Role Access Based Control for a Windows Server 2003
as an example. Please set up the server in your accountability.

To configure the schema for Role Based Access Control, you must create a schema first.
D P.39 “Creating the schema for Role Based Access Control”

Then configure the attribute value for each user.

3 P.41 “Configuring attribute value for each user’

Creating the schema for Role Based Access Control

Before adding the schema for Role Based Access Control for Windows Server 2003, you must
install the Administration Tools Pack. The installation method varies depending on whether the
Service Pack is installed or not.
- When the Service Pack 1 is not installed:
Right-click the “adminpak.msi” file in the “i386” folder in the Windows Server 2003 CD-ROM
and select [Install].
- When the Service Pack 1 is installed:
Right-click the “adminpak.msi” file in the “WINDOWS\system32” folder in the local disk and
select [Install].

Click the [Start] menu and select [Run...].

* The Run dialog box appears.

Enter “mmc /a” and click [OK].
* The Console1 window appears.

Click the [File] menu and select [Add/Remove Snap-in...].
¢ The Add/Remove Snap-in dialog box appears.

Click [Add] in the [Standalone] tab.
* The Add Standalone Snap-in dialog box appears.

Select “Active Directory Schema” and click [Add]. Then click
[Closel].

* It returns to the Add/Remove Snap-in dialog box.

Confirm that “Active Directory Schema” is added in the list and
click [OK].
e It returns to the Console1 window.

oo O A WODN

7 Right-click “Active Directory Schema” in the left pane of the
Console1 window and select [Change Domain Controller...].
* The Change Domain Controller dialog box appears.
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8 Confirm that “Current DC” displays the correct domain controller
name and click [OK].
e It returns to the Console1 window.

If “Current DC” does not display the correct domain controller name, select “Specify
Name” and enter the correct domain controller name. Then click [OK].

9 Right-click “Active Directory Schema” in the left pane of the
Console1 window and select [Operations Master...].
¢ The Change Schema Master dialog box appears.

1 0 Confirm that “Current schema master (online)” displays the correct
schema master name and click [Close].
* It returns to the Console1 window.

If “Current schema master (online)” does not display the correct schema master name,
click [Change] to specify the correct schema master name. Then click [Close].

1 1 Browse “Active Directory Schema” in the left pane of the Console1
window. Then right-click the “Attributes” folder and select [Create
Attribute...].

¢ The Schema Object Creation dialog box appears.

1 2 Click [Continue].
* The Create New Attribute dialog box appears.

1 3 Enter each item as described below and click [OK].
Common Name: eBMUserRole
LDAP Display Name: eBMUserRole
Unique X500 Object ID: 1.3.6.1.4.1.1129.2.100.1.1

Description: <Any Strings> (Optional)
Syntax: Unicode String
Minimum: 1

Maximum: 256

When you create a new attribute with wrong settings, the settings cannot be modified. In
that case, delete the wrong attribute that you create and create an attribute again.

1 4 Select the “Classes” folder in the left pane in the Console1 window.
Then right-click “person” in the right pane and select [Properties].
* The person Properties dialog box appears.

1 5 Display the [Attribute] tab and click [Add].
¢ The Select Schema Object dialog box appears.

1 Select “eBMUserRole” and click [OK].

* |t returns to the person Properties dialog box.
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17
18

19
20
21
22

Click [OK] to close the person Properties dialog box.

¢ It returns to the Console1 window.

Select the “Classes” folder in the left pane in the Console1 window.
Then right-click “group” in the right pane and select [Properties].
* The group Properties dialog box appears.

Display the [Attribute] tab and click [Add].
¢ The Select Schema Object dialog box appears.

Select “eBMUserRole” and click [OK].

* |t returns to the group Properties dialog box.

Click [OK] to close the group Properties dialog box.

¢ It returns to the Console1 window.

Click the [File] menu and select [Save As...] to save the settings.
Then restart the server.
* The added schema becomes effective after restarting the server.

Configuring attribute value for each user

Before configuring the attribute value for each user, you must install the Windows Support Tools.
To install the Windows Support Tools, right-click the “suptools.msi” file in the “support\tools”
folder in the Windows Server 2003 CD-ROM and select [Install].

1
2
3

Click the [Start] menu and select [Run].
* The Run dialog box appears.

Enter “Idp” and click [OK].
¢ The Ldp window appears.

Click the [Connection] menu and select [Connect...].
¢ The Connect dialog box appears.

Enter the IP address of the Active Directory Server in the “Server”
field, and click [OK].
¢ |t returns to the Ldp window.

Click the [Connection] menu and select [Bind...].
* The Bind dialog box appears.

Enter the administrator name, password, and domain name to login
the Active Directory Server. Then click [OK].
¢ It returns to the Ldp window.

Click the [View] menu and select [Tree].
* The Tree View dialog box appears.
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Enter the base domain name in the “BaseDN” field and click [OK].
¢ |t returns to the Ldp window.

Tip

In the BaseDN field, you must enter the base domain name in the Base DN format.
For example, to specify “Idap.ifax.com”, enter “dc=Idap,dc=ifax,dc=com”.

9 Browse “CN=Users,DC=...” in the left pane. Then right-click the
user object that you want to set the attribute value and select [Mod-

ify].
* The Modify dialog box appears.

1 0 Enter “eBMUserRole” in the “Attribute” field, and enter the values
in the “Values” filed. Then click [Enter].

* When you add the eBMUserRole attribute as a new attribute, select “Add” in the
“Operation” option.
* When you modify the eBMUserRole attribute that you set before, select “Replace” in
the “Operation” option.
Tip
For detailed information about values, please see the description on page 39.

1 1 Click [Run] and click [Close] to save the settings.
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Troubleshooting

This section describes the troubleshooting for this equipment.

Troubleshooting OVervieW..........cccciemmimiiinerrr s 44
Network Connectivity ProbIEMS ........ccouiiiiie et e s 44
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Troubleshooting Overview

This chapter is the place to start if you are experiencing difficulties installing or using this equip-
ment. Because the system integrates hardware, network, and software components, errors
occur. And variations between network configurations and user setup further complicate the
troubleshooting process.

The purpose of this chapter is to help you locate the origin of an error if it is not immediately
apparent, and then direct you to subsequent chapters for instructions on resolving the issue.
Checklists provided in this chapter help you identify the subsystem most likely to be responsible
for the error condition.

Troubleshooting client software and output errors are not described in this manual, the following
manuals can assist you in those efforts:

- Output Errors: Printing Guide

- Document Monitor Error Condition and Messages: Printing Guide

- Printer Driver Installation Error Messages: Printing Guide

- Printer Driver General Errors: Printing Guide

- Printer Utility Error Condition: Printer Utility Guide

- TWAIN Driver and File Downloader Error: e-Filing Guide

- N/W-Fax Driver Error: Network Fax Guide

- Address Book Viewer Error: Network Fax Guide

Network Connectivity Problems

Problem Description

The many variables within a network environment make installing an integrated device challeng-
ing. The easiest environment in which to install the controller is over TCP/IP using a DHCP
server to dynamically assign and resolve |IP addresses between devices.

Using default configuration settings also assures an easier implementation. However, you may
be required to customize the settings to accommodate your particular environment.

Some common network configuration options are shown below, along with the steps required to
configure this equipment. If you perform all the steps in the applicable checklist and still cannot
print satisfactorily to this equipment, contact your authorized dealer for further assistance.

You can change network protocol settings using the Touch Panel Display or Printer Utility
(Administration page).
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SMB/Point&Print Printing in a Windows Operating System Environment:

No | Check... Yes No For Instruction, Go To...

1 Are the IP Address proper- | Next Step N Setup the IP address correctly.
ties correctly set? U

2 | Is the Microsoft Computer Next S Setup the device name correctly.
Name (Device Name) ext@ tep =
unique?

3 | Is the Workgroup name Next Step o Setup the workgroup correctly.
valid and correctly entered? U

4 | Is the WINS server address Setup the WINS server address
correctly set? Next Step o correctly, or enter “0.0.0.0” for the

U WINS server address to disable
the WINS service.

5 | If the client computers are Setup the WINS server and
located in different seg- Next Step o enable it on this equipment to
ments, is the WINS service U allow users access from different
correctly provided? segment.

6 | Can you see this equipment Refer to following section to trou-
in Windows Network Neigh- | Next Step N bleshoot the condition.
borhood? U [ P.60 “Cannot See This Equip-

ment”

7 | Were the proper printer driv- | Next Step N See the Printing Guide to install
ers installed? U proper printer drivers.

8 | Is the driver’s port name Next Step N See the Printing Guide to config-
valid? U ure proper port.

9 | Can you print to this equip- Refer to following section to trou-
ment? End N bleshoot the condition.

L3 P.61 “Cannot Print To This
Equipment”
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Raw TCP or LPR Printing in a Windows Operating System Environment:

No | Check... Yes No For Instruction, Go To...
5 | Are the IP Address proper- | Next Step N Setup the IP address correctly.
ties correctly set? U
6 | Is the Raw TCP Printing Next Step o Setup the Raw TCP print service
correctly set? U correctly.
7 | Is the LPR/LPD Printing cor- | Next Step N Setup the LPD print service cor-
rectly set? U rectly.
8 | Were the proper printer driv- | Next Step o See the Printing Guide to install
ers installed? U proper printer drivers.
9 | Isthe Raw TCP or LPR port N See the Printing Guide to config-
configured with correct IP ext@Step = ure the proper port.
address?
10 | Can you print to this equip- Refer to following section to trou-
ment? bleshoot the condition.
End = w . .
L P.61 “Cannot Print To This
Equipment”

IPP Printing in a Windows Operating System Environment:

No | Check... Yes No For Instruction, Go To...
1 Are the IP Address proper- | Next Step o Setup the IP address correctly.
ties correctly set? U
2 | Isthe HTTP Server on this | Next Step o Enable the HTTP server in the
equipment enabled? U HTTP Network Service.
3 | Is the IPP Printing correctly | Next Step o Setup the IPP print service cor-
set? U rectly.
4 | Were the proper printer driv- | Next Step o See the Printing Guide to install
ers installed? U proper printer drivers.
5 | Is the IPP port configured Next Step o See the Printing Guide to config-
with correct URL? U ure proper port.
6 | Can you print to this equip- Refer to following section to trou-
ment? bleshoot the condition.
End = w . .
L P.61 “Cannot Print To This
Equipment”
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Novell Printing in a NetWare Environment:

No | Check... Yes No For Instruction, Go To...

1 | Are the IPX/SPX protocol N Setup the IPX/SPX correctly.
enabled? Is the correct ext@Step =
frame type selected?

2 | If applicable, did you suc- Next S Setup the NetWare server prop-
cessfully set up queue- ext@ tep = erly.
based printing?

3 | Did you configure this Next S Setup the NetWare network set-
equipment for NetWare con- ext@ tep = tings correctly.
nection?

4 | Did you configure this Setup the Novell print service cor-

; . Next Step
equipment for Novell print ) = rectly.
service?

5 | Were the proper printer driv- | Next Step o See the Printing Guide to install
ers installed? ¥ proper printer drivers.

6 | Is the IPP port configured Next Step o See the Printing Guide to config-
with correct URL? U ure the proper port.

7 | Can you see this equipment Next S Check that the SMB protocol is
in Windows Network Neigh- ext@ tep = enabled in client computers.
borhood?

8 | Can you print to this equip- Refer to following section to trou-
ment? End N bleshoot the condition.

L P.61 “Cannot Print To This
Equipment”
Macintosh Environment:
No | Check... Yes No For Instruction, Go To...

1 Is AppleTalk enabled on this | Next Step o Enable the AppleTalk.
equipment? g

2 | Are the IP Address proper- | Next Step o Setup the IP address correctly.
ties correctly set? 3

3 | Is this equipment available Make sure the AppleTalk zone is
in the Chooser when you Next Step N supported by the Macintosh cli-
click the LaserWriter 8 4 ent.
printer icon?

4 | Can you access any other Next St Refer to your Macintosh network-
network device from the ex ) ep = ing documentation or contact
Macintosh computer? Macintosh technical support.

5 | Can another Macintosh Refer to your Macintosh network-
computer on the network ing documentation or contact
print to this equipment? If Macintosh technical support.
so, compare the settings to End =

determine which need to be
changed to support printing
from this machine.
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Unix Environment:

No | Check... Yes No For Instruction, Go To...
1 Are the IP Address proper- | Next Step N Setup the IP address correctly.
ties correctly set? U
2 | Isthe LPR/LPD Printing cor- | Next Step o Setup the LPD print service cor-
rectly set? U rectly.
3 | Did you successfully install | Next Step N See the Printing Guide to install
the Unix filters? U Unix filters.
4 | Did you successfully create | Next Step o See the Printing Guide to config-
and set up the print queue? U ure the print queue.
5 | Can you print to this equip- Setup Unix access for this equip-
ment using LPD as root? ment to enable other users to
Next@Step > print from the Bourne shell. Refer
to your Unix documentation for
more information.
6 | Can you ping this equip- Try remote ping from another
ment from your computer? server. If you can reach this
Next Step N equipment from that server, check
U for conflicts between this equip-
ment and your current network
segment.
7 Is the LP Daemon function- | Next Step N Reload Daemon or restart the
ing? 4 system.
8 | Can you print to this equip- Contact your service representa-
End = .
ment? tive.

Cannot Discover Device

Problem Description

This equipment is discovered automatically using SNMP.

When Document Monitor, TWAIN driver, File Downloader, and Address Book Viewer cannot
automatically discover this equipment over the network, the most likely cause is limitations of the
protocols on the supporting computers. In some cases, you need to add or update network com-
ponents.

The following checklist helps you identify the source of the error and directs you where you can
find more information about resolving it. If the problem persists after you have followed all of the
steps, contact a authorized dealer for further assistance.

No | Check... Yes No For Instruction, Go To...
1 | Is the SNMP enabled on Enable the SNMP (MIB) and con-
this equipment? firm the Read Community and
Is “public” is specify for the | Next Step N Read Write Community setting.
Read Community? U
Is “private” is specify for the
Read Write Community?
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No

Check...

Yes

No

For Instruction, Go To...

Confirm that the protocol
suite installed on the client
computer has been updated
with the latest software for
the given operating system.
If your network only sup-
ports the IPX/SPX protocol,
make sure that the most
current version of Novell Cli-
ent software is installed.

Next Step
4

See the vendor’s Web site for
information about product
updates and technical supports.

Print a NIC Configuration

page from this equipment.
Does this equipment sup-
port the same protocol as
the network?

Next Step
4

Configure the proper protocol.

Change the protocol set-
tings from Printer Utility, if
necessary, and reboot the
equipment for the changes
to take effect. Repeat step
2. Was the device discov-
ered?

End

Next Step
4

Check the NIC Configura-
tion page. Are the IP
Address and subnet mask
settings correct?

Next Step
4

Setup the TCP/IP settings cor-
rectly.

Check the router to make
sure it is not filtering out this
equipment packets. Is the
router processing equip-
ment packets correctly?

Next Step
4

Adjust the router settings.

Can another computer
within the same network
segment discover this
equipment?

Next Step
4

Refer to following section to trou-
bleshoot the condition.

L1 P.44 “Network Connectivity
Problems”

Check the NIC Configura-
tion page. Is the Unit Serial
Number part of the device
name?

Next Step
4

Check link activities on the
port being used by this
equipment and the integrity
of the network cable, hub,
or switch that connects this
equipment to the network.
Replace any network com-
ponents that you can tell or
suspect are faulty.

End

Contact your service representa-
tive.
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Cannot Ping the Device

Problem Description

If this equipment does not respond when you ping it, there is a problem either with the network
configuration or with device operation.

The following checklist helps you identify the source of the error and directs you where you can
find more information about resolving it. If the problem persists after you have followed all of the

steps, contact your authorized dealer for further assistance.

No

Check...

Yes

No

For Instruction, Go To...

1

Confirm that the TCP/IP
protocol suite is installed on
the client computer.

Next Step
4

The networking section of your
operating system documentation.

Look at the NIC configura-
tion page and confirm the
TCP/IP settings are correct.
Is the IP Address entered
and valid? Are the Gateway
and Subnet settings cor-
rect?

Next Step
4

Enter the correct TCP/IP settings.

Reboot this equipment.
Check the NIC Configura-
tion page that prints out. Are
the TCP/IP settings correct?

Next Step
4

The settings are not binding, con-
tact your service representative.

Try to ping this equipment
again. Did this equipment
respond to the ping?

End

Next Step
4

Can you ping this equip-
ment from any other com-
puter within the same
network? If not, this equip-
ment might have an IP
Address that is out of range
or invalid.

Next Step
4

Contact your local network spe-
cialist for a valid IP address for
this equipment.

Can you ping to another
computer within the same
network?

Next Step
4

Check the computer’s protocol
settings to make sure the gate-
way and subnet settings are cor-
rect.

If you have customized the
device name, you can
check if the NIC is func-
tional by restoring the
default settings. When this
equipment automatically
reboots and a NIC Configu-
ration page prints, does the
device name include the
NIC’s Unit Serial Number?

Next Step
4

The NIC is faulty or improperly
installed. Contact your service
representative.
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No | Check... Yes No For Instruction, Go To...

8 | Check link activities on the Contact your service representa-
port being used by the tive.

equipment and also the
integrity of the network
cable, Hub, or Switch that is
connecting the equipment
to the network. Replace any
network components that
you suspect are faulty. Can
you ping this equipment
now?

End =

Cannot Print From Client

Problem Description

After following the instructions in this guide to install and configure your hardware, network, and
client software, you are still unable to print from a client computer to this equipment. This prob-
lem can arise as the result of a hardware malfunction, a network communication or configuration
problem, or incorrect client setup or driver properties.

The following checklist will help you identify the source of the errors and direct you to information
resolving the issue. If a problem persists after you have followed all of the steps, contact your

authorized dealer for further assistance.

No | Check... Yes No For Instruction, Go To...

1 | Is the copier functioning Next S Check the device status dis-
normally? Do copy jobs out- ext& tep = played in the Device tab page of
put properly? Printer Utility.

2 | Check the Device page of Contact your service representa-
Printer Utility. Are the tive.
options specified for the job Next S
supported by the hardware ext@ tep =
configuration? If not, delete
the job, install the required
components, and try again.

3 | Can you print jobs from Refer to following section to trou-
other client computers? Next Step N bleshoot the condition.

U 3 P.61 “Cannot Print To This
Equipment”

4 | At this point, the problem you have identified is most likely related to a client-side error.

Refer to the Printing Guide to troubleshoot the error condition.
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Network or Touch Panel Display Disabled After LDAP Search

Problem Description
After performing the LDAP search, the network or Touch Panel Display will be disabled.

No | Check... Yes No For Instruction, Go To...
1 | Isthe LDAP server correctly | Next Step o Check the LDAP server is cor-
running? U rectly running.
2 | Is the LDAP server setting Enter the correct LDAP setting.

correctly set? Especially re-enter the correct
password carefully because it dis-

plays with asterisks.

End =

LDAP Authentication Takes a Long Time

Problem Description
It takes a long time to perform the LDAP authentication on the touch panel.

No | Check... Yes No For Instruction, Go To...
1 Is the LDAP server correctly | Next Step N Check the LDAP server is cor-
running? U rectly running.

2 | Is the LDAP server setting Enter the correct LDAP setting.
correctly set? Especially re-enter the correct

End = o
password carefully because it dis-
plays with asterisks.

52 Troubleshooting Overview



Troubleshooting Hardware Errors

The topics in this chapter cover errors or faults that affect normal copier or controller operation.

This includes, but is not limited to, the following conditions:

* Faulty or improperly installed system board, cables, and connectors.

¢ Faulty or malfunctioning copier components, such as standard or optional finishing units, the
Auto Duplexer Unit (ADU), or the Large Capacity Feeder (LCF).

* Corrupt or outdated system software or copier firmware.

Resolving copier operation problems falls outside the scope of this guide, but this chapter will
assist you in interpreting error messages and then identifying the source of a problem. If you

determine that the problem is related to copier operation, refer to the Operator’s Manual for
Basic Function.

This chapter also covers how to use the administration utility, Printer Utility, to diagnose and
resolve hardware-related errors. For more information about resolving error messages dis-
played on the Touch Panel Display, refer to the Operator’s Manual for Basic Function or the
Touch Panel Display online Help.

Common Errors

Startup Page Does Not Print

Problem Description

If a startup page does not print when you power on this equipment, even though the print startup
page is enabled, there is a hardware error. Contact your authorized dealer for further assis-
tance.

Print Jobs Not Output

Problem Description

Most often, this problem is the result of a software error, such as incorrectly set driver property.
However, if you cannot output print jobs from any computer, the cause is probably a hardware
error.

Refer to the Printing Guide for more information on resolving output errors caused by incorrect
software settings.

The following checklist will help you identify the source of the error and direct you to information
resolving the issue. If the problem persists after you have followed all of the steps, contact your
authorized dealer for further assistance.

No | Check... Yes No For Instruction, Go To...
1 Is printing prohibited from all Refer to the following section to
connected client comput- Next Step o troubleshoot the condition.
ers? U [ P.44 “Troubleshooting Over-
view”
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No | Check... Yes No For Instruction, Go To...

2 | Is the job visible from Refer to the following section to
Printer Utility or other print Next S troubleshoot the condition.
monitoring utility, such as ext@ tep = LD P.60 “Troubleshooting Net-
PCONSOLE or Print Man- work Errors”
ager?

3 | Are you able to identify the Refer to the Operator’s Manual
problem from the error mes- End = for Basic Function to trouble-
sage and resolve it? shoot the condition.

Device Status Indicators

Copier Maintenance Calls

You can use Printer Utility to check if this equipment requires maintenance. The Device Sum-
mary window includes a device icon that displays visual Device Status Indicators in the event of
a device malfunction.

¢ Printer Error 1

The above printer error icon indicates that non-recommended toner is used. For information
on resolving the error condition, refer to “REPLACE TONER CARTRIDGE SYMBOL” in
Operator’s Manual for Basic Function.

¢ Printer Error 2

A

The above printer error icon indicates:

You need to remove paper from standard output tray.

You need to remove paper from Job Separator.

You need to remove paper from Finisher tray.

You need to remove staples jammed in the Finisher. For information on resolving the
error condition, refer to “CLEAR PAPER SYMBOL” in Operator’s Manual for Basic
Function.

You need to clear hole punches from Finisher. For information on resolving the error con-
dition, refer to “DISPOSING OF THE PUNCHED PAPER BITS (OPTIONAL)” in Opera-
tor’s Manual for Basic Function.

Non-recommended toner is being used. For information on resolving the error condition,
refer to “REPLACE TONER CARTRIDGE SYMBOL” in Operator’s Manual for Basic
Function.

You need to remove excess staples from the Saddle Stitch Finisher.

You performed saddle stitch printing using mixed paper sizes.

Cannot load paper from the LCF.

Cannot output to inner tray.

* Cover Open

S

The Cover Open error icon indicates that you need to close the cover.
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Drawer Open

=

The Drawer Open error icon shows which drawer is open: upper, middle, or lower. You must
close the specified drawer to resume printing and copying functions.
Toner Empty

\E

The Toner Empty icon indicates that the toner is empty.

For information on resolving the error condition, refer to “REPLACE TONER CARTRIDGE
SYMBOL” in Operator’s Manual for Basic Function.

Toner Full

=

The Toner Full error icon indicates you need to replace the toner container. For information
on resolving the error condition, refer to “REPLACE TONER BAG SYMBOL” in Operator’s
Manual for Basic Function.

Paper Empty

L

The Out of Paper error icon shows which drawer is empty: upper, middle, or lower. A paper
out condition does not necessarily terminate a print or copy job. If Auto-select options are
configured, printing and copying may continue by drawing paper from a different drawer.
Refer to the Printer Utility online Help for instructions on setting up Auto-Select mode. For
information on resolving the error condition, refer to “ADD PAPER SYMBOL” in Operator’s
Manual for Basic Function.

Paper Jam

2

The Device Status icon varies depending on where a paper jam occurred in the copier. This
graphic illustrates the possible locations. For information on resolving the error condition,
refer to “CLEAR PAPER SYMBOL” in Operator’s Manual for Basic Function.

Staple Empty

The Add Staples error icon indicates you need to add staples to the finisher. For information
on resolving the error condition, refer to “ADDING STAPLES (OPTIONAL)” in Operator’s
Manual for Basic Function.

Serviceman Calls

J

The Service Call error icon indicates that a call for service is needed. Contact your service
representative.
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Printer Utility Error Messages

Message Log

The error messages displayed in the Touch Panel Display are described in the Operator’s Man-
ual for Basic Function.

Printer Utility Message Corrective Action

Front Cover Open - Please Close Cover. Close the Front Cover.

Paper Feeding Cover Open - Please Close Cover. | Close the Paper Feeding Cover.

Transfer/Transport unit Open - Please Close Close the Transfer/Transport unit.

Cover.

Large Capacity Feeder Cover Open - Please Close the Large Capacity Feeder Cover.
Close Cover.

Drawer Open - Please Close Cover. Close the drawer.

Automatic Duplexing Unit Cover Open - Please Close the Automatic Duplexing Unit Cover.
Close Cover.

Relay Unit Cover Open - Please Close Cover. Close the Relay Unit Cover.

Finisher Joint Cover Open - Please Close Cover. Close the Finisher Joint Cover.

Staple Door Open - Please Close Cover. Close the Staple Door.

Lower Tray Delivery Cover Open - Please Close Close the Lower Tray Delivery Cover.

Cover.

Lower Tray Front Cover Open - Please Close Close the Lower Tray Front Cover.

Cover.

Punch Unit Front Cover Open - Please Close Close the Punch Unit Front Cover.

Cover.

Hole Punch Unit Open - Please Close Cover. Close the Hole Punch Unit.

Paper Jam in Auto Duplexer Unit - Please Clear Refer to HELP on the Touch Panel Display to
Paper Path remove jammed paper.

Paper Jam in Printer - Please Clear Paper Path Refer to HELP on the Touch Panel Display to
remove jammed paper.

Paper Ejection Jam - Please Clear Paper Path Refer to HELP on the Touch Panel Display to
remove jammed paper.

Paper Insertion Jam - Please Clear Paper Path Refer to HELP on the Touch Panel Display to
remove jammed paper.

Staple Jam in Finisher - Please Clear Staple Remove jammed staples from the Finisher. Refer
to the Operator’s Manual for Basic Function for
instruction.

Staple Jam in Saddle Stitch Finisher - Please Clear | Remove jammed staples from the Saddle Stitch
Staple Finisher. Refer to the Operator’s Manual for
Basic Function for instruction.
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Printer Utility Message

Corrective Action

Hole Punch Jam in Finisher - Please Clear Hole
Punch

Clear hole punches from the Finisher. Refer to the
Operator’s Manual for Basic Function for
instruction.

Used Toner Container Full - Please Replace.

Replace the toner container. Refer to the Opera-
tor’s Manual for Basic Function for instruction.

Toner Not Recognized - Please Check Toner.

Check and adjust the toner bottle.

Black Toner Empty - Please Reéfill.

Replace the black toner. Refer to the Operator’s
Manual for Basic Function for instruction.

Automatic Document Feeder Error - Please Con-
tact Service Technician.

Contact your service representative.

Alignment Error in Automatic Document Feeder -
Please Contact Service Technician.

Contact your service representative.

Motor Error in Automatic Document Feeder -
Please Contact Service Technician.

Contact your service representative.

I/F Error in Automatic Document Feeder - Please
Contact Service Technician.

Contact your service representative.

Fatal Error - Please Contact Service Technician.

Contact your service representative.

Main Motor Error - Please Contact Service Techni-
cian.

Contact your service representative.

Printer Output Error - Please Contact Service
Technician.

Contact your service representative.

Printer Input Error - Please Contact Service Tech-
nician.

Contact your service representative.

Expired scan documents deleted from share folder.

Expired documents are deleted automatically from
the “SCAN” folder in the “SHARE_FILE” folder.

Expired Sent Fax documents deleted from share
folder.

Expired documents are deleted automatically from
the “TXFAX” folder in the “SHARE_FILE” folder.

Expired Received Fax documents deleted from
share folder.

Expired documents are deleted automatically from
the “RXFAX” folder in the “SHARE_FILE” folder.

Scanned documents in shared folder deleted upon
user’s request.

Documents in the “SCAN” folder have been
deleted by a users

Sent Fax documents in shared folder deleted upon
user’s request.

Documents in the “TXFAX” folder have been
deleted by a user.

Received Fax documents in shared folder deleted
upon user’s request.

Documents in the “RXFAX” folder have been
deleted by a user.

Failed to delete file.

The file cannot be deleted from the shared folder.

Failed to acquire resource.

The file cannot be acquired from the shared folder.

Document(s) expire(s) in a few days.

There are documents to be deleted in a few days
in e-Filing.

Hard Disk space for Electronic Filing nearly full.

The hard disk has a few disk space available.
Delete unnecessary documents to maintain the
hard disk space.
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Printer Utility Message

Corrective Action

Power failure occurred during e-Filing restoring.

The document could not be stored in e-Filing
because of the power failure.

SMTP Destination Error has been detected in the
received mail. This mail was deleted.

This equipment cannot received the Email that
does not contain the sender’s Email address. Ask
the sender to send the Email again with entering
the sender’s Email address.

OffRamp Destination limitation Error has been
detected in the received mail.

This equipment cannot perform the Offramp trans-
mission to more than 40 destinations. Ask the
sender to send the Offramp document separately
for every 40 destinations.

Fax Unit Error has been occurred in the received
mail.

This equipment cannot perform the Offramp trans-
mission without the optional Fax unit.

POP3 Connection Error has been occurred in the
received mail.

Make sure the POP3 server is properly running.
Make sure correct IP address of the POP3 server
is assigned.

POP3 Connection Timeout Error has been
occurred in the received mail.

Make sure that the network cable is correctly con-
nected. Make sure the POP3 server is properly
running.

POP3 Login Error has been occurred in the
received mail.

Make sure the correct login name and password is
specified.

POP3 Login Error occurred in the received mail

Make sure that the POP3 login type (Auto, POP3,
APOP) is set correctly.

File 1/0 Error has been occurred in this mail. The
mail could not be received until File 1/O is recov-
ered.

Turn OFF then ON the power and confirm if the
equipment can receive the Internet Fax. If the
Internet Fax document cannot be received, con-
firm that any files other than TIFF and text files are
attached in the Internet Fax.

Hard Disk space for File Share nearly full.

The hard disk has a few disk space available.
Delete unnecessary documents to maintain the
hard disk space.

Domain - General Failure during Authentication

Please verify the Network Settings again and retry
connecting to the domain controller.

Domain - Invalid Username or Password

Please recheck the username and password and
Please confirm if the Caps Lock key is switched on
by accident.

Domain - Server not present in Network

The server is not on network or it could not be
located. Also please check the DNS and DDNS
settings on Printer Utility.

Domain - User account is disabled on Server

Please confirm the User attributes on the server.
This can be verified in -> Active Directory Users
and Computers.

Domain - User account has expired and cannot be
used for logon

Please change the account expiration date and
retry again. The expiration date can be modified
from Active Directory Users and Computers.

Domain - User account is locked and cannot be
used for logon

The lockout duration could be specified in account
lockout security policy. If so please retry after the
lockout duration.
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Printer Utility Message

Corrective Action

Domain - Invalid logon hours for the User

The Administrator has set restrictions on the logon
hours. The logon hours can be modified from
Active Directory Users and Computers.

Active Directory Domain - Clock Skew error due to
difference in Time between Server and MFP

The clocks need to be synchronized. Please con-
firm if SNTP is configured correctly on the equip-
ment.

Active Directory Domain - Kerberos Ticket has
expired and cannot be used for Authentication

Please confirm the validity period of the ticket set
by the Kerberos server. Please retry again after the
fresh ticket is issued.

Active Directory Domain - Verification of the Ticket
has failed

Please verify the username and password and
retry again. If the problem persists please contact
the Administrator.

Active Directory Domain-The Domain specified
could not be found

Please enter the correct domain name in network
settings. If the problem persists please contact the
Administrator for the correct realm name for your

server.

Information Failed User Authentication

Check DomainName/UserName/Password

SNTP Server - Connect Error has occurred

The equipment could not connect to the SNTP
Server. Please confirm the SNTP settings.
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Troubleshooting Network Errors

If you cannot print to this equipment from a network-connected computer, and you have ruled
out both faulty and malfunctioning hardware and incorrectly installed or configured software as
the cause, the problem is most likely to be network related.

This chapter describes the most common network configuration problems and provides steps to
resolving them. If the problem persists after you have followed all of the steps, contact Océ’s
authorized dealer for further assistance.

Cannot See This Equipment

Problem Description

After configuring this equipment, you cannot see it on the network. This could be the result of
configuration conflicts within this equipment, but is more likely to be caused by network configu-
ration errors.

The following checklist helps you identify the source of the error and directs you where you can
find more information about resolving it. If the problem persists after you have followed all of the
steps, contact Océ’s authorized dealer for further assistance.

No | Check... Yes No For Instruction, Go To...

1 Did a startup page print out? Setup the proper protocols.
If not, wait until the commu-
nication comes online.
Examine the protocol set-
tings that print out on the
startup page. Are they cor-
rect?

Next Step
4

2 | Print out a configuration Setup the proper protocol if
page. Make sure there are required.

not any discrepancies or Once you find this equipment,
inconsistencies between the configure the port that it is
current network settings mapped correctly to the device.
and your network environ-
ment. Change the network | Next Step
settings, if necessary. Use U

the Find Computer utility
from your Windows com-
puter to locate this equip-
ment by its device name.
Can you find this equip-
ment?

3 | Can you locate other com- Check the network settings on the
puters that are in the same | Next Step client computer to make sure they

network as this equipment? U are compatible with the network

settings on this equipment.

4 | Check link LED activity on Contact your Océ service repre-
the hub and/or NIC of this sentative.

equipment and the client Next Step

machine. Do the hardware U
components appear to be
functioning properly?
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No

Check...

Yes

No

For Instruction, Go To...

Make sure that the device
name for this equipment is
unique and verify that the
WINS and/or DNS server
database are not causing
potential naming conflicts
with the network settings on
this equipment. If neces-
sary, change the network
settings on this equipment.
After the communication
comes back online, can you
see this equipment in the
network?

End

Next Step
4

Setup the NetBIOS name of the
device correctly.

If the network environment
is using complex subnet or
supernet structures, is the
IP address used by this
equipment within the net-
work structures range of
valid addresses?

End

Please contact your local network
support specialist for further
assistance.

Cannot Print To This Equipment

Problem Description

You are unable to print to this equipment. Before troubleshooting the network problems, please

see the following section to narrow the problem down to a network-related issue.
P.51 “Cannot Print From Client”

For example, network printing services have not been set up correctly, or this equipment has not

been properly configured to operate in your network environment.

The following checklist will help you identify the source of the error and direct you to information
resolving the issue. If the problem persists after you have followed all of the steps, contact Océ’s

authorized dealer for further assistance.

No

Check...

Yes

No

For Instruction, Go To...

1

Have you set the protocol
settings so they are compat-
ible with your network and
client protocol settings?

Next Step
4

Setup the proper protocol.

Have you set up the appro-
priate type(s) of print ser-
vices should be supported?

Next Step
4

Check the settings required for
your printing environment.

If you are using Novell print
services, did you set up the
Novell side of network print-
ing, such as creating print
servers and attaching the
print queue?

Next Step
4

Setup the NetWare server.

If you set up Novell print
services, can you see the
print job using PCONSOLE
or NWAdmin?

Next Step
4

Refer to your Novell PCONSOLE
or NWAdmin user documentation
for help with using these utilities.
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No | Check... Yes No For Instruction, Go To...

5 | Have you checked the gate- Setup the TCP/IP correctly.
way and subnet settings to
make sure this equipment is
part of the same network Next@Step =
Gateway as the client from
which you are trying to
print?

6 | Are other services and com- Refer to your network documen-
munications performed over tation or use a network diagnostic
the network behaving in the End = utility to research a network prob-
normal and expected man- lem.
ner?
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Appendix

This section shows the default settings of this equipment.

Default Setting List .......ccccciiiiiiirierrnr s 64
Default Settings for General SEtHNG. ........ccoiiiiiiiiee e e e 64
Default Settings for Network Setting .........ooceiiiiiiii e 64
Default Settings for Copier SEtiNgG ..........eii i 67
Default Settings for Fax Setting (OptioNal).............uiiiiiiiiiiiie e 68
Default Settings for Save as file Setting.........ooi i 68
Default Settings for Email Setting ...........ooiiiiiiii e 69
Default Settings for Internet Fax Setting ..........oociviiiiie e 69
Default Settings for Printer Setting..........ooo i 69

Default Settings for Print SEIVICE ......cooouii i 69



Default Setting List

This chapter describes the default settings of this equipment.

Default Settings for General Setting

Device Information

Department Code.........cceviiiiiiniiieiiieeeeeeee e OFF
Department Code Enforcement ............ccccceeeevnnenennnn. OFF
€-FiliNg ..o Enable
QUEUE NAIME ..t print

[0 071 i o] o IS Undefined
Contact Information..............oooveuieiiiiii Undefined
Service Phone NUMbEr..........cccceeeeeiiiiiiiiieeen Undefined
Administrative Message...........cccceeviiiiee i Undefined
Administrator’s Password ..........cccooeeeeeeiiiiiiiiiiiiieennn.. Undefined
Energy Save

YU | (o YO 1Y T 45 seconds
AULO POWET SAVE .....oevviiviiiiiiieieeeee e 15 minutes
Auto Power Off........cuviiiiiieieeeeeee e 60 minutes

Time Stamp

Year/Date/Time .....cccooiiiieeeeeiiieeee et Defined appropriately
TiME ZONE ...ttt Defined appropriately
Date FOrmat........ooooiiiiiiiiee e MM/DD/YY

Daylight MOdE ..o OFF

Web General Setting

Web Language.........coooociiiieeiiiiieee e English
SESSION TIMEN ..o 10 minutes

Default Settings for Network Setting

TCP/IP

Address Mode..........oooiiiiiiiie e Dynamic

Obtain a Domain Name automatically......................... Disable

Obtain a Domain Server Address automatically ......... Disable

Obtain a WINS Server Address automatically ............ Disable

Obtain a SMTP Server Address automatically............ Disable

Obtain a POP3 Server Address automatically ............ Disable

Obtain a SNTP Server Address automatically ............ Disable

IP ADArESS ....ooviiiiiiieeie et Undefined

SUBNEt MASK .....ccueeriiiiiiiriiceee e Undefined

Default Gateway ..........ccccooeeiiiiiiiiieeee e Undefined

IP FIEriNG ..coeieii et Start Address End Address
FIIter 1 e 0.0.0.0 0.0.0.0
FIlter 2 ..o 0.0.0.0 0.0.0.0
FIlter 3 ..o 0.0.0.0 0.0.0.0
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FIlter 4 ..o 0.0.0.0 0.0.0.0
FIEr 5 .o 0.0.0.0 0.0.0.0
FIItEr 6 ..o 0.0.0.0 0.0.0.0
FIIEI 7 e 0.0.0.0 0.0.0.0
FIlter 8 ..o 0.0.0.0 0.0.0.0
FIlter 9 .. 0.0.0.0 0.0.0.0
FIlter 10 . e 0.0.0.0 0.0.0.0

IPX/SPX

Enable IPX/SPX ... Enable

Frame TYPE ......uueeeiiiiiieiiieieeee et e e Auto Sense

Actual Frame..........oooiiiiiiiie e Undefined

AppleTalk

Enable AppleTalk ... Enable

Device Name .......ococviiiiiiiee e MFP_[NIC Serial Number]

DeSired ZOoNe .......coouviiiiiiiiee e *

Bonjour

Enable Bonjour ... Enable

Link-Local Host Name...........cccocviiiiiinicieee e MFP_INIC Serial Number]

Service Name ........ooceviiiiiiii e Oce im4530-[serial]

Oce im2830-[serial]

LDAP Session

Enable LDAP ... Enable
ENAbIE SSL ..o Disable

DNS Session

Enable DNS ... Enable
Primary DNS Server Address .........cccceeeovevneeenieennne 0.0.0.0
Secondary DNS Server AJdress ........cccccceveveeeeniieeens 0.0.0.0

DDNS Session

Enable DDNS ... Enable
HOStNaME ... s MFP-[NIC Serial Number]
Domain Name ...........cooooviiiieceeeeeeee e Undefined

SMB Session

SMB Server ProtoCol ..........ccccvveieeeiiieeesiie e Enable

NetBIOS Name .......c.ovveeiiieee e MFP-[NIC Serial Number]
WOTK GrOUP ..o tiieie ettt e workgroup

DOMAIN....ciiiiie e Undefined

Primary Domain Controller...........ccccoevviiinieiiicenen. Undefined

Backup Domain Controller...........cccceevieiiiiienienenen. Undefined
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Logon User Name
Password

Primary WINS Server.........cccccocoe..
Secondary WINS Server.................

SMB Signing of SMB Server
SMB Signing of SMB Client

NetWare Session

Enable Bindery..........ccccceiiie.

Enable NDS

HTTP Network Service

Enable HTTP Server
Enable SSL
Primary Port Number
Secondary Port Number
SSL Port Number

SMTP Client

Enable SMTP Client........c..cccvuuueee.

Enable SSL
SSL/TLS
SMTP Server Address
POP Before SMTP
Authentication
Login Name
Password
Maximum Email / Internet Fax Size

Port Number..........cccccoeeeeeeiiiiiiiiienn,

SMTP Server
Enable SMTP Server

Port Number..........cccceeeeeeeiiieiieiienn,

Email Address
Enable OffRamp Gateway
OffRamp Security
OffRamp Print

POP3 Network Service

Enable POP3 Client
Enable SSL
POP3 Server Address
Authenticaion
Type POP3 Login
Account Name

Undefined
Undefined
Undefined
Undefined

If client agrees
If server agrees

Enable

Undefined
Undefined
Undefined

Enable
Disable
Undefined
Undefined
Disable
Disable
Undefined
Undefined

Enable
Disable
Undefined
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PasSSWOId .....coooeieieiiiieeee e Undefined

SCAN RALE ....uviiiiiiiiiieeeeeee s 5 minutes
POrt NUMDET ... 110
SSL Port NUMDET ......ccooieiieieceeee e 995

SNTP Service

Enable SNTP ....ooooiiiieeecee e Disable
Primary SNTP Address.........ccooveeiiiieniiicec e Undefined
Secondary SNTP Address .......ococevevieeeiiie e Undefined
SCAN RALE ....eeeii e 24 hours
Port NUMDer ... 123

FTP Client

Default Port NUMDber .......cccccvvvieieieieiieeeeeeeeeeeeeeeeeee, 21
FTP Server

Enable FTP Server .......cooooooovivveeeiiieeeeeee e Enable
ENAbIE SSL ... Disable
Default Port NUMber .......ccccoovvveieiieiieeeeeeeeeeeeeeeeeee, 21

SSL Port NUMDET .....cccoiiiiiiieeeeee e 990

SNMP Network Service

Enable SNMP ... Enable
Read Community ........ccoeeriiiiiieiiiee e public
Read Write Community .........ccoooviiieiiiiiiieeeee e private
Enable Authentication Trap........ccccooveriiiiiiiencercen. Enable
Enable Alerts Trap .......coooeoeeiiiiiiieeeeeeee e, Enable
IP Trap AdAress™ .......ccccuveiiiiiiiiiieeeeeeeeee e 0.0.0.0
IP Trap AdAress2 ........cccuviviiiieiiiiiieeeeee e 0.0.0.0
IP Trap AdAreSS3 ......oooiiiiiiiie e 0.0.0.0
IP Trap AdAreSS4 ........coociiiiieeieieiee e 0.0.0.0
IP Trap AdAresss ........oooevieiiiieeiiiee e 0.0.0.0
IP Trap AdAressb .........cccuvvvieeeiiieiieieeeeeee e 0.0.0.0
IP Trap AdAress7 ......ccccvviiviiiieiiieeeeeeeee e 0.0.0.0
IP Trap AdAress8 ........ccccuvveiiieiiiiieieeeeee e 0.0.0.0
IP Trap AdAress9 .......oooiiiiiiiee e 0.0.0.0
IP Trap AdAress10 ......ccocviiiieeiieiee e 0.0.0.0
IP Trap CommuUNIty .......oooviiiiiiiieiecee e public
IPX Trap AdAress.........uuvieeeieieieieeee e eeeccciivineenes Undefined

Security Service

Certificate for Wireless LAN ............ceeeeeeeieiiiiiiiiiiinn. Not Installed
Server Certificate ..........oooovviviiieiieeeee e, Not Installed
(07 N 07=Y 4 (1i{o7=1 (= Not Installed

Default Settings for Copier Setting

Original Mode.........ccooiiiiieiiiiieee e Text/Photo
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EXPOSUNE ... Auto

Bypass FEed ........ccouviiiiiiiiiiee e Plain

BOOK > 2. Open from left
Magazine Sort..........cooiiiiiiiiiee e Open from left
2IN1/4INT oo Write Laterally
Maximum COpIES ......ccooeiiieeeeeeeee e 999

Auto 2-sided Mode..........cccviriiniiciiieeee e OFF

Sorter Mode Priority .........cooecviieiieiiiiee e No-Sort

Default Settings for Fax Setting (Optional)

Terminal ID NUMDbEr .........ooviiiiiieie e Undefined

Fax NUMDET ... Undefined

Line2 Number NOTE e Undefined

Monitor VOIUME ........coviiiieeiiee et 4 (Max. 7)

Completion VoIUMEe.........c.cooiiiiiiieiieeeeee e 5 (Max. 7)

Reception Mode..........ccooovviiiiiiicee e Auto

Dial TYPE oo MF

Dial Type (Line2) NOTE e MF

Line-2 Mode™OTE s TX/Rx

RESOIUtION ..o Standard

Original Mode.........ccooiiiiiiiiiiieee e Text

EXPOSUIE ...t Auto

LI 1 SRR ON

R e e s OFF

ECM s ON

[ 1=T o7 (o USRS ON

RedUCHioN .....coooiiiie e OFF

DUpIEX Print .....oeiiiiiieeeeee e OFF

Rotate Sort.........oooiiiiiiie OFF

Recovery Transmit.........ccoocviiiiiiiiiiicnc e OFF

Journal Auto Print ... ON

Memory Transmission Report..........ccccoociieiiienennne ON ERROR (Print 1st Page Image)
Multi Transmission Report .........cccoocoeiviiiviieeciieee ON ERROR (Print 1st Page Image)
Polling REPOIt ... ON ERROR

Relay Originator ..........occcviiieiiii e Always (Print 1st Page Image)

“Line2 Number”, “Dial Type (Line2)”, and “Line-2 Mode” is available only when optional Line2
board is installed on the Fax unit.

Default Settings for Save as file Setting

Local Storage Path..........cccoviiiiiniee e FILE_SHARE

Storage Maintenance ...........cccoooeeeiiieeice i Delete documents after 30 days

Destination ...........oooiiiiiiiii e Do not allow any network folder to be
used as a destination

Remote 1 ..o Disabled

REMOLE 2 ... Disabled

N/W-Fax Destination...........cccceevvieiiine e Do not allow any network folder to be
used as a destination

N/W-Fax Folder.........cccooiiiiiiiiiiie e Disabled
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Default Settings for Email Setting

From Address
From Name .......oiiiiiiieeecceee e
File FOrmat........oooeiiiiiiiiecceee e
Fragment Message Size .........cccccoveiiiieiiiiiecieccee,
Default Body Strings

Default Settings for Internet Fax Setting

From Address
From Name ........ooooiiiii e
Fragment Page Size .........ccccevviieiiiiicieee e
Default Body Strings
Body Strings TransmissSion.........ccoccvvevveeeiiieeenier e,

Default Settings for Printer Setting

General Setting

Number of days to save Private,

Proof and Invalid JOb ........ccoooiiiiiiiiee
LT<-=>A4/LD<-->A3......eeeeeeeeee e
Print Startup Page........cccoooeiiieicee e

Default Raw Job Setting

Raw Jobs - Duplex Printing........cccccceveveeeeeeiieieee
Raw Jobs - Default Paper Size .........ccccccovieiivinennen.
Raw Jobs - Default Paper Type ........ccccccvveveeeiiiinneenn.
Raw Jobs - Default Orientation ...........c.cccccocieeiiinnee.
Raw Jobs - Default Stapling...........cccceeeeeeeneeeneeenee.
Raw Jobs - Default Output Tray........ccccceeevieeeiieeennee.
PCL FOrm LiN€ ...ccooeieeiiie e
PCL FONt PitCh..coooiiieeeee e
PCL Font Point Size.........cccociiiiiiiiiiieee e
PCL Font Number ...
PCL Line Termination..........cccccooiiiiiiieiiiiiee e
Symbol Set ...
Paper SOUICE ........cccuveiiiiiceie e
Do not Print Blank Pages..........cccoovviveiiiieninccee,

Raw Job Setting
Raw Job Setting........coooeiiiiiiic e

Default Settings for Print Service

Raw TCP Print

Enable Raw TCP
POrt NUMDET ...

Undefined
Undefined
PDF(Multi)
No Fragmentation
Undefined

Undefined
Undefined
No Fragmentation
Undefined

12.0

Disable

Default Setting List

69



Enable Raw bi-directional ..............ccccoeeeeeiiiiiiiiiiiinnnn, Disable

LPD Print

Enable LPD .........oomeeeeee e Enable
Port NUMDEr ..., 515
BaANNEIS.....eeeeceeeeeeeeeeee e OFF
IPP Print

Enable IPP ... Enable
Port80 Enable .........coevveeeiiiiiiieeeeeeee e Enable
POrt NUMDET ... 631

URL o http://<IP address>:631/Print
ENAbIE SSL ... Disable
SSL Port NUMDET.....ceveiieiiiiieeeeeeeeeeeeeeeeeeeee e 443
SSLURL i https://<IP address>:443/Print
Administrator’'s Name..........ccccceeeeeiiiiiiiiiieiieeeee e admin
Administrator’s Password ..........ccccoooeeviiiiiiiiiiiieeeennn. 123456
Authentication ..o Disable
USEr NaAME ...t user
PassWord .......coovvviiiiiiii e password
FTP Print

Enable FTP Printing ........coccooiiiiiiieeeeeeeeee Enable
POrt NUMDET ... 21
PrintUser Name ..........cccoeeeeeiiiiiiiiiiccceee e, Print

Print Password.............ceeeiiiiiiiiiieeeeee e Undefined

NetWare Print

LOGin NamME......oooiiiiiiiiee e MFP_[NIC Serial Number]
PassSWOrd .........ooooiiiiiieeee e Undefined
Print Queue Scan Rate............cc.oovvvvieeeiieiee, 5 seconds

Email Print

Enable Print Header..........cccocooveiiiiiiiiiieeeeeeeeeeeeee Disable
Enable Print Message Body........cccceeviiiiiiiiiniincnen. Enable
Maximum Email Body Print..........ccocoiiniiniii 5

Enable Print Email Error ..........ooovvvvviiiiieeieieeeeee, Enable
Enable Email Error Forward..............oooovviieeeieeeeeennnn, Disable
Email Error Transfer Address........cocvveeeeeeeeeeeeieieeennnn, Undefined
Enable Partial Email..............coooooviiiiiiiiiieeieeeeeeeeeeee Enable
Partial wait time...........oooveeeeiiie e 24 hours
MDN REPIY...ooiiiiiiiiieeiie e Disable
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